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Обзор урока

Здесь мы рассмотрим:

• что нового в приложении Adobe Premiere Pro;

• нелинейный видеомонтаж в приложении Adobe Premiere Pro;

• стандартный рабочий процесс обработки видеоматериала;

• оптимизацию рабочего процесса при помощи высокоуровневых 
возможностей;

• внедрение возможностей Adobe® Creative Cloud® в рабочий процесс;

• рабочий процесс Adobe Creative Cloud;

• рабочее пространство Adobe Premiere Pro;

• размещение панелей в рабочем пространстве приложения;

• настройку рабочего пространства.

� Выполнение данного урока займет примерно 45 минут.

Перед тем как приступить к работе, вы вкратце ознакомитесь 
с процессом видеомонтажа и ролью в нем приложения Adobe Premiere 
Pro. Даже те, кто уже набил руку в видеомонтаже, найдут для себя много 
нового в обзоре функциональных возможностей данной программы.
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Приложение Adobe Premiere Pro — это система видеомонтажа, 
которая поддерживает самые передовые технологии и видеокамеры, 
предоставляя мощные, простые в использовании и легко интегрируемые 
практически с любым источником видео инструменты.
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Начало работы

В наши дни наблюдается растущая потребность в высококачественном 
видеоконтенте и постоянная смена старых технологий новыми. Но не-
смотря на все эти стремительные изменения, цель видеомонтажа с тече-
нием времени остается одной и той же: используя исходный материал, 
придать ему ту форму, которая позволит эффективно донести сообщение 
до целевой аудитории.

Приложение Adobe Premiere Pro CC — это система видеомонтажа, которая 
поддерживает самые передовые технологии, предоставляя мощные, про-
стые в использовании и легко интегрируемые практически с любым источ-
ником видео инструменты, вместе с широкой гаммой подключаемых моду-
лей и других средств, предназначенных для окончательного монтажа.

Сначала вы познакомитесь со стандартным процессом работы, которого 
придерживается большинство видеомонтажеров. Затем узнаете о месте 
приложения Premiere Pro в семействе продуктов Adobe Creative Cloud. 
Наконец, вы получите представление об основных компонентах пользо-
вательского интерфейса приложения Adobe Premiere Pro и узнаете, как 
создавать ваши собственные рабочие пространства.

Нелинейный монтаж в приложении Adobe Premiere Pro

Приложение Adobe Premiere Pro  — это программа для нелинейного мон-
тажа, которая позволяет вам помещать, заменять и перемещать отсня-
тый видеоматериал в том порядке, который должен быть в конечном ви-
деофайле. В любой момент времени вы можете внести изменения в какой 
угодно сегмент вашего видеоклипа. Больше не нужно выполнять монтаж 
в строго определенном порядке, вы можете изменить любую часть ваше-
го видеопроекта, когда захотите.

Допускается объединять несколько клипов в последовательности, которые 
в дальнейшем можно монтировать одним щелчком или перетаскивать при 
помощи мыши. Вы можете изменить любую часть последовательности, 
в любом порядке, изменить содержимое последовательности, переместив 
клипы так, чтобы они воспроизводились в нужной очередности, выполнить 
смешивание слоев видео, добавить спецэффекты и многое другое. Кроме 
того, разрешается объединить вместе несколько последовательностей.

Вам больше не нужно бесконечно перематывать весь объем материала 
вперед и назад в поисках одного единственного, но значимого кадра — 
для этого достаточно сделать один щелчок мышью. С программой Pre-
miere Pro организовать клипы так же легко, как организовать файлы на 
вашем компьютере.
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Программа  Adobe Premiere Pro поддерживает форматы видео как лен-
точных, так и безленточных устройств видеосъемки, включая форматы 
XDCAM EX, XDCAMHD 422, DPX, DVCProHD, AVCHD (включая 
AVCCAM и NXCAM), AVC-Intra и DSLR. Кроме этого, программа так-
же поддерживает самые передовые форматы, применяемые для хранения 
необработанного видео, с улучшенной поддержкой камер RED и камер 
ARRI Alexa. Теперь перенос отснятого видеоматериала в проект стал еще 
быстрее и проще, и вам в большинстве случаев больше не придется кон-
вертировать видеофайлы перед их использованием.

Стандартный рабочий процесс видеомонтажа

Приобретя достаточный опыт в области видеомонтажа, вы разработае-
те свой собственный план работы над всеми аспектами вашего проекта. 
Каждый шаг требует применения различных навыков и инструментов. 
Кроме того, время, потраченное на тот или иной этап, будет зависеть от 
конкретного проекта.

Независимо от того, пропустите вы некоторые шаги, заменив их беглой 
проверкой, или же потратите на них часы (или даже дни!), доводя до со-
вершенства некий аспект вашего проекта, план действий будет состоять 
из следующих этапов:
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1 Съемка видеоматериала. Этот этап может включать запись началь-
ного видеоматериала или сбор необходимых исходных файлов для 
проекта .

2 Захват (передача или импорт) видеоматериала на жесткий диск. При 
работе с ленточными носителями видеоданных приложение Adobe 
Premiere Pro (при наличии соответствующего оборудования) может 
автоматически преобразовывать видеоматериал в файлы на вашем 
компьютере. При работе с безленточными носителями информации 
программа позволяет считывать видеоданные напрямую, без необхо-
димости их конвертации. В этом случае обязательно создавайте ре-
зервную копию исходных данных

3 Организация клипов. В наши дни проекты могут содержать огром-
ное множество фрагментов видеоматериала. Потратьте необходимое 
время, чтобы организовать клипы, используемые в вашем проекте, 
при помощи специальных папок, называемых корзинами. Вы также 
можете добавить цветовые метки и метаданные (дополнительную ин-
формацию о клипах) для организации видеоматериала.

4 Сборка фрагментов видео- и аудиоматериала в последовательность 
и добавление их на монтажный стол.

5 Создание монтажных переходов между клипами, применение видео-
эффектов и выполнение композитинга путем размещения клипов на 
нескольких слоях (дорожках).

6 Создание титров или изображений и добавление их в вашу последо-
вательность. Используется та же методика, что и при работе с видео-
клипами.

7 Микширование нескольких звуковых дорожек для получения прием-
лемого уровня громкости и применение монтажных переходов и спе-
циальных эффектов к аудиоклипам для улучшения качества звука.

8 Экспорт завершенных проектов на видеоленту, в файл на жесткий 
диск компьютера, в потоковый видеоролик для воспроизведения во 
Всемирной паутине, на мобильное устройство, на диски формата 
DVD или Blu-ray.

Приложение Adobe Premiere Pro поддерживает все перечисленные шаги 
при помощи наилучших инструментов в данной отрасли.

Расширение рабочего процесса при помощи 
высокоуровневых функций

Приложение Adobe Premiere Pro предоставляет простые в использова-
нии инструменты для стандартного процесса видеомонтажа. Кроме того, 
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вы получаете доступ к инструментам с расширенными возможностями 
для управления, монтажа и тонкой настройки ваших проектов.

Скорее всего, вы не будете использовать многие из них в своих первых 
видеопроектах. Но по мере развития навыков и постановки более слож-
ных задач нелинейного монтажа вы придете к тому, что станете исполь-
зовать все высокопроизводительные возможности.

В книге освещены следующие темы.

• Улучшенный монтаж звука : приложение Adobe Premiere Pro пред-
лагает звуковые эффекты и монтаж, которых нет ни в одной другой 
программе для нелинейного монтажа и в большинстве программ для 
обработки звука. Создавайте и помещайте каналы объемного звука 
в режиме 5.1, монтируйте звуковое сопровождение на уровне сэм-
плов, применяйте несколько звуковых эффектов к любому звуково-
му клипу или дорожке, используйте уже включенные в программу 
передовые модули и дополнительные модули Virtual Studio Technol-
ogy (VST).

• Коррекция цвета : корректируйте и улучшайте качество отснятого 
материала при помощи улучшенных цветокорректирующих филь-
тров. Вы также можете создавать вспомогательные области для цве-
товой коррекции, которые позволят вам изменять отдельные цвета на 
фрагментах изображения, чтобы улучшить композицию.

• Средства  управления ключевыми кадрами : приложение Adobe Pre-
miere Pro предоставляет возможность четкого контроля, который не-
обходим для точной настройки визуальных эффектов и анимации без 
необходимости экспортировать их в приложения для создания ком-
бинированных изображений. Для работы с ключевыми кадрами при-
меняется стандартный пользовательский интерфейс, поэтому, освоив 
работу с ним в одном приложении, вы сможете использовать полу-
ченные навыки во всех продуктах семейства Adobe Creative Cloud, 
где это возможно.

• Широкая поддержка  аппаратного обеспечения : выбирайте из мно-
жества устройств захвата  и других аппаратных средств, чтобы ском-
поновать систему, наилучшим образом удовлетворяющую вашим 
потребностям и бюджету. Программа Adobe Premiere Pro поддержи-
вается как на недорогих компьютерах для монтажа видео в формате 
DV и сжатого видео высокого разрешения (HDV), так и на высоко-
производительных рабочих станциях, захватывающих видео высоко-
го разрешения (HD), 4K и трехмерное стереоскопическое видео.

• Увеличение производительности видеокарты при помощи движка 
Mercury Playback Engine : данный механизм работает в двух режи-
мах — «только программное обеспечение» или в режиме ускорения 
графического процессора (GPU). Использование последнего требует, 
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чтобы компьютер не только отвечал минимальным системным тре-
бованиям, но и был оснащен видеокартой соответствующей модели. 
Список совместимых видеокарт можно найти на официальном сайте 
Adobe — www.adobe.com/ru/products/premiere/tech-specs.html.

• Мультикамерный  монтаж : можно легко и быстро монтировать лю-
бой материал, сцены которого отсняты одновременно на несколько 
камер. Приложение Adobe Premiere Pro показывает видеоизображе-
ние со всех камер в разделенном на части окне монитора. Можно пе-
реключаться между видеоклипами, щелкая по нужному окну мышью 
или используя сочетания клавиш, а также автоматически синхрони-
зировать видео, снятое с разных ракурсов, со звуковым сопровожде-
нием проекта.

• Управление проектами: управляйте всеми рабочими файлами 
в одном диалоговом окне. Просматривайте, удаляйте, перемещай-
те, находите и организуйте клипы и корзины. Собирайте проекты, 
перемещая используемые в работе данные в одно определенное ме-
сто. Затем освобождайте дисковое пространство, удаляя ненужные 
файлы .

• Метаданные: приложение Adobe Premiere Pro поддерживает техно-
логию Adobe XMP, позволяющую сохранять дополнительную инфор-
мацию о файлах в виде метаданных, которые допустимо просматри-
вать в других приложениях. Эту информацию можно использовать 
для поиска клипов или для передачи ценных сведений, например об 
интересных материалах, между приложениями.

• Творческие титры: создавайте титры и изображения с использова-
нием инструмента Premiere Pro Title Designer. Вы также можете ис-
пользовать изображения, созданные практически в любом графиче-
ском редакторе, при этом многослойные документы Adobe Photoshop 
допустимо импортировать либо в виде одного слоя, либо в виде от-
дельных слоев, которые можно вставлять, объединять и анимировать 
независимо друг от друга.

• Расширенные возможности обрезки клипов: используйте специ-
альные инструменты обрезки для подгонки клипов и точного разме-
щения склеек. В приложении Adobe Premiere Pro CC возможности 
таких инструментов значительно улучшены, чтобы позволить вам 
выполнять сложную обрезку нескольких клипов одновременно.

• Кодирование в мультимедийные форматы: экспортируйте свою 
последовательность, чтобы создать видео- и аудиофайл, полностью 
соответствующий вашим требованиям. Используйте расширен-
ные возможности приложения Adobe Media Encoder для создания 
нескольких копий готовой последовательности в различных фор-
матах.
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Расширение рабочего процесса

Несмотря на то, что приложение Premiere Pro можно использовать как 
отдельный продукт, фактически оно является «командным игроком». Ве-
роятнее всего, вы используете приложение Adobe Premiere Pro в составе 
семейства продуктов Creative Cloud, а это значит, что у вас есть доступ 
к другим специализированным инструментам. Но даже если вы приобре-
ли только приложение Adobe Premiere Pro, в вашем распоряжении ока-
жутся программы Adobe After Effects, Adobe SpeedGrade и Adobe Prelude. 
Узнав, как различные программные продукты работают вместе, вы сможе-
те повысить производительность труда и расширить ваши возможности.

Внедрение компонентов Creative Cloud в рабочий процесс

Приложение Adobe Premiere Pro — это универсальный инструмент для 
монтажа видео- и аудиофайлов, однако он является всего лишь одной из 
составляющих семейства продуктов Adobe Creative Cloud — комплекс-
ной среды дизайна для печати, Всемирной паутины и видео, которая 
включает ориентированное на видеопроекты программное обеспечение 
для выполнения следующих операций:

• создание профессиональных эффектов трехмерной анимации;

• комплексная анимация титров;

• подготовка многослойной графики;

• создание векторных иллюстраций;

• производство музыки.

Чтобы использовать одну или несколько из этих возможностей в рабочем 
процессе, можно обратиться к другим приложениям, входящим в пакет 
Adobe Creative Cloud. В нем содержатся все компоненты, необходимые 
для создания профессиональных видеопроектов.

Далее приведено краткое описание остальных продуктов семейства Cre-
ative Cloud :

• Adobe After Effects CC  . Инструмент для видеомонтажеров, создаю-
щих анимированную графику и визуальные эффекты.

• Adobe Photoshop CC . Профессиональная программа для редактиро-
вания изображений и создания графики. Вы можете работать с фото-
графиями, видеофайлами и трехмерными объектами, чтобы подгото-
вить их к использованию в своем проекте.

• Adobe Audition CC  . Мощный инструмент для обработки, очистки от 
шумов и улучшения звука, а также создания музыки и наложения за-
кадрового голоса.
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• Adobe Encore CS6 . Высококачественный продукт для авторинга 
мультимедийных дисков. Приложение Encore содержит средства для 
подготовки стандартных дисков DVD и Blu-ray, а также интерактив-
ных SWF-файлов.

• Adobe Illustrator CC . Профессиональное программное обеспечение 
для создания векторной графики для печати, видеопродукции и Все-
мирной паутины.

• Adobe Dynamic Link  . Приложение, выстраивающее связи между 
программами, которое позволяет вам работать в режиме реального 
времени с мультимедийными файлами и последовательностями при 
обмене ими между программами After Effects и Adobe Premiere Pro.

• Adobe Bridge CC . Визуальный файловый браузер, предоставляющий 
централизованный доступ к файлам проектов, приложениям и на-
стройкам пакета Creative Cloud.

• Adobe Flash Professional CC  . Программа, являющаяся своего рода 
стандартом де-факто в сфере создания многофункционального инте-
рактивного контента для Всемирной паутины.

• Adobe SpeedGrade CC. Профессиональный инструмент для выпол-
нения сложной коррекции цветов с поддержкой передовых видео-
форматов и трехмерного стереоскопического видео.

• Adobe Prelude CC. Программа, позволяющая импортировать, пере-
кодировать мультимедийные файлы, добавлять к ним метаданные, 
метки и теги. Создает черновой монтаж, который затем можно пере-
дать непосредственно в Adobe Premiere Pro или другую программу 
нелинейного монтажа с помощью XML.

• Adobe Media Encoder CC. Программа, поддерживающая пакетную 
обработку файлов, созданных в программах Premiere Pro и Adobe Af-
ter Effects.

Профессиональный рабочий процесс в программном 
обеспечении Adobe

Процесс работы в программе Adobe Premiere Pro, входящей в состав паке-
та Creative Cloud,  будет различен в зависимости от ваших потребностей 
при работе над проектом. Приведем несколько возможных сценариев.

• Используйте приложение Photoshop CC для обработки и применения 
эффектов к статичным изображениям, снятым на цифровую камеру, 
полученным при помощи сканера или извлеченным из видеоклипов. 
Затем используйте их в приложении Adobe Premiere Pro.

• Создавайте многослойную графику в приложении Photoshop CC, затем 
открывайте ее в программе Adobe Premiere Pro. Вы можете сделать так, 
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что каждый слой появится на отдельной дорожке монтажного стола, 
что позволит применять эффекты и анимацию к выбранным слоям.

• Импортируйте большое количество аудио- или видеофайлов при по-
мощи приложения Adobe Prelude CC, добавив ценные метаданные, 
временные комментарии и теги. Создайте последовательности из 
подклипов в приложении Adobe Prelude и отправьте их в программу 
Premiere Pro для последующей обработки.

• Отправьте аудиоклип непосредственно с монтажного стола програм-
мы Premiere Pro в программу Adobe Audition для очистки от шумов 
и дополнительной обработки звукового сопровождения.

• Отправьте последовательность из программы Premiere Pro в при-
ложение Adobe Audition для выполнения профессионального мик-
ширования звука. Программа Premiere Pro позволяет автоматически 
создать из вашей последовательности сессию в программе Adobe Au-
dition, включив в нее видеоряд, чтобы вы могли монтировать аудио-
дорожку с учетом происходящего на экране действия.

• Используя приложение Dynamic Link, откройте последовательность 
видеоклипов приложения Adobe Premiere Pro в программе After Ef-
fects CC . Примените специальные эффекты и анимацию, а затем про-
смотрите получившиеся результаты в приложении Adobe Premiere 
Pro. Вы можете проигрывать композиции приложения After Effects 
в программе Adobe Premiere Pro CC без предварительного просчета, 
а также использовать преимущества функции After Effects СС Global 
Cache, которая сохраняет композиции в оперативной памяти для их 
дальнейшего просмотра.

• Используйте приложение After Effects CC для создания и анима-
ции титров способами, значительно превосходящими возможности 
приложения Adobe Premiere Pro. Используйте готовые композиции 
в программе Adobe Premiere Pro при помощи программы Dynamic 
Link. Изменения, выполненные в приложении After Effects, незамед-
лительно отображаются в приложении Premiere Pro.

• С помощью встроенных предустановок экспортируйте видеопроекты 
в формате Blu-ray-дисков (H.264-совместимых файлов) и используй-
те их в программе Encore CS6  для создания DVD- и Blu-ray дисков 
или интерактивных Flash-приложений.

Большая часть этой книги посвящена рассмотрению «стандартного» ра-
бочего процесса, в котором используется только приложение Adobe Pre-
miere Pro. Но в нескольких уроках будет продемонстрировано примене-
ние остальных компонентов пакета Adobe Creative Cloud для получения 
более впечатляющих результатов.
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Обзор рабочего пространства программы 
Adobe Premiere Pro

Для начала будет полезно бегло ознакомиться с пользовательским ин-
терфейсом программы Adobe Premiere Pro, чтобы в следующих уроках 
вы могли легко применять изученные инструменты. Для упрощения на-
стройки пользовательского интерфейса в программе Premiere Pro при-
меняются рабочие пространства. Они позволяют размещать различные 
панели и инструменты на экране таким образом, чтобы максимально 
оптимизировать процесс выполнения определенных действий, например 
при выполнении монтажа, работе со специальными эффектами или об-
работке звука.

Сейчас мы кратко ознакомимся с рабочим пространством для видеомон-
тажа. В этом упражнении вы будете использовать проект для приложе-
ния Adobe Premiere Pro , который находится на DVD-диске, прилагаемом 
к данной книге. Для достижения наилучшей производительности обяза-
тельно скопируйте файлы уроков на жесткий диск вашего компьютера.

1 Убедитесь, что переписали все папки уроков  и их содержимое с DVD-
диска на жесткий диск вашего компьютера. Мы рекомендуем хранить 
скопированные материалы в папке My Documents\Adobe\Premiere 
Pro\CC\Lessons (Windows) или Documents/Adobe/Premiere Pro/CC/ 
Lessons (OS X).

2 Запустите приложение Adobe Premiere Pro.

• Примечание. 
Рекомендуется ско-
пировать папки всех 
уроков с DVD-диска на 
ваш жесткий диск и не 
удалять их до тех пор, 
пока вы не закончите 
обучение; в некоторых 
уроках имеются ссылки 
на материалы предыду-
щих заданий.

• Примечание. 
Возможно , откроется 
диалоговое окно с за-
просом указания на 
расположение того или 
иного мультимедийно-
го файла. Это произой-
дет, если исходные 
файлы сохранены не 
на том жестком диске, 
который вы исполь-
зуете для работы. Вам 
нужно будет вручную 
указать приложению 
Adobe Premiere Pro 
местонахождение 
файла, отыскав его на 
компьютере. В данном 
примере перейдите 
в папку Lessons/Assets 
и выберите файл, ко-
торый нужно открыть, 
в диалоговом окне. 
Приложение Premiere 
Pro обновит пути 
к остальным файлам 
проекта автоматиче-
ски.
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В окне приветствия приложения Adobe Pre-
miere Pro вы можете создать новый проект 
или открыть ранее сохраненный.

3 Щелкните  мышью по кнопке Open Proj-
ect (Открыть проект).

4 В диалоговом окне Open Project  (От-
крыть проект) перейдите в папку Les-
son 01, которая расположена в папке 
Lessons на вашем компьютере, и дважды 
щелк ните мышью по файлу проекта Lesson 01.prproj, чтобы загрузить 
в приложении Adobe Premiere Pro первый урок.

Схема рабочего пространства

Перед началом работы над проектом убедитесь, что в программе 
Adobe Premiere Pro открыто рабочее пространство, используемое по 
умолчанию. Выберите команду меню Window ⇒ Workspace ⇒ Edit-
ing (Окно ⇒ Рабочее пространство ⇒ Монтаж), затем команду Win-
dow ⇒ Workspace ⇒ Reset Current Workspace (Окно ⇒ Рабочее про-
странство ⇒ Сброс текущего рабочего пространства). В появившемся 
диалоговом окне нажмите кнопку Yes (Да).

Если  вы  пока  не знакомы с нелинейным монтажом, то вас, скорее всего, 
поразит рабочее пространство, используемое по умолчанию, на котором 
присутствует огромное количество элементов управления. Не беспокой-
тесь. Все станет гораздо проще, когда вы узнаете назначение каждого эле-
мента управления. 

Схема размещения панелей и инструментов на рабочем пространстве 
очень тщательно продумана. На следующем рисунке приведены основ-
ные элементы рабочего пространства.

Каждый элемент рабочего пространства отображается на собственной 
панели. Можно сгруппировать несколько панелей в один фрейм (стоп-
ку). Некоторые элементы, наиболее активно используемые, ни с чем объ-
единить нельзя, например монтажный стол, панель звукового микшера 
и монитор программы. 

Ниже приведены основные элементы монтажной области:

• Монтажный стол. Здесь производится основная часть всего монта-
жа — создание и работа с последовательностями (термин, используе-
мый в продуктах Adobe для отдельных видеофрагментов или всего 
проекта). Главное свойство последовательностей заключается в том, 
что их можно вкладывать — помещать одни в другие. Таким образом 
объемный проект можно разделить на легкоуправляемые части.

• Примечание. 
Файлы всех проектов 
Adobe Premiere Pro 
имеют расширение 
.prproj .
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А Монитор источника
Б Панель Effect Controls 

(Управление эффекта-
ми) (скрыта)

В Панель звукового мик-
шера (скрыта)

Г Монитор программы

Д Панель Project (Проект)
Е Браузер материалов 

(скрыт)
Ж Панель Info (Информа-

ция) (скрыта)
З Панель Effects (Эффек-

ты) (скрыта)

И Панель Markers (Мар-
керы) (скрыта)

К Панель History (Исто-
рия) (скрыта)

Л Клипы
М Последовательность
Н Панель инструментов

О Дорожки
П Монтажный стол
Р Индикатор Audio Mas-

ter Meters (Контроль-
ные измерители уровня 
звука)

БA

Д

Л

М
Н

О

П

Р

Е Ж З И К

В Г

• Дорожки  . Можно наслаивать (то есть комбинировать) видеоклипы, 
изображения, графику и титры на неограниченном количестве доро-
жек. Видеоклипы перекрывают все остальные материалы, распола-
гающиеся на дорожках, находящихся ниже на монтажном столе. Сле-
довательно, клипам, располагающимся на первых по счету (верхних) 
дорожках, нужно задавать определенную степень прозрачности или 
уменьшать их размер, если вы хотите, чтобы через них были видны 
клипы, расположенные ниже.

• Панели  мониторов . Вы будете работать с монитором источника, рас-
полагающимся слева, чтобы просматривать и обрезать необработан-
ный исходный видеоматериал. Чтобы просмотреть клип на мониторе 
источника , дважды щелкните мышью по файлу на панели Project 
(Проект). Монитор программы, расположенный справа, предназна-
чен для просмотра монтируемой последовательности. Некоторые 
монтажеры предпочитают работать с одним монитором. В уроках дан-
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ной книги описана работа с двумя мониторами. Но при желании вы 
можете использовать только один из них. Нажмите кнопку Close (За-
крыть) возле имени вкладки монитора источника, чтобы закрыть его. 
Выберите команду меню Window ⇒ Source Monitor (Окно ⇒ Мони-
тор источника), чтобы снова открыть этот монитор.

• Панель  Project  (Проект). Здесь размещаются ссылки на файлы ис-
ходных материалов проекта: видеоклипы, звуковые файлы, графику, 
неподвижные изображения и последовательности. Для организации 
исходных материалов можно использовать специальные папки   — 
корзины.

• Браузер материалов . Эта панель позволяет находить нужные файлы 
материалов в файловой системе компьютера. Данная возможность 
чрезвычайно полезна при работе с видеоматериалами, представлен-
ными в виде файлов.

• Панель Effects   (Эффекты). Тут содер-
жатся все эффекты, которые вы будет 
применять в своих последовательностях, 
включая видеофильтры, звуковые эф-
фекты и переходы (эта панель по умол-
чанию состыкована с панелью Project 
(Панель)). Эффекты сгруппированы по 
типам для упрощения их поиска в про-
цессе работы.

• Панель Audio Clip Mixer (Микшер ау-
диоклипа). Интерфейс этой панели (по 
умолчанию состыкованной с панеля-
ми Source (Источник), Effect Controls 
(Управление эффектами) и Metadata 
(Метаданные)) очень похож на аппа-
ратные средства звукозаписывающей студии своими регуляторами 
уровня громкости и ручками панорамирования: по одному набору 
элементов управления для каждой аудиодорожки на монтажном сто-
ле. Общие корректировки, внесенные вами, применяются к аудио-
клипам в целом, в то время как изменения, произведенные на панели 
Audio Track Mixer (Микшер аудиодорожек), применяются к дорож-
кам.

• Панель  Effect Controls  (Управление эффектами). Эта панель (по 
умолчанию состыкованная с панелями Source (Источник), Audio Clip 
Mixer (Микшер аудиоклипа) и Metadata (Метаданные), и доступная 
через меню Window (Окно)) содержит элементы управления любыми 
эффектами, примененными к выбранному клипу на монтажном сто-
ле. Для любого видеоклипа, фотоснимка или рисунка всегда доступно 
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три видеоэффекта: Motion (Движение), Opacity (Непрозрачность) 
и Time Remapping (Перераспределение времени). Большинство пара-
метров эффектов можно изменять с течением времени.

• Панель  Tools  (Инструменты). Каждая кнопка на данной панели пред-
ставляет собой отдельный инструмент, выполняющий определенную 
функцию в процессе работы над проектами. Инструмент Selection 
(Выделение) — контекстно-зависимый. Это означает, что внешний 
вид указателя мыши при использовании данного инструмента меня-
ется в зависимости от выполняемой в данный момент функции. Если 
курсор выглядит не так, как ожидалось, возможно, вы выбрали не-
правильный инструмент.

• Панель  Info  (Информация). Панель Info (Информация) (по умол-
чанию состыкованная с панелью Project (Проект) и браузером мате-
риалов) отображает информацию о текущем состоянии любого объ-
екта, выделенного на панели Project (Проект), или любого клипа или 
перехода, выделенного в последовательности.

• Панель  History  (История). Эта панель (по умолчанию состыкован-
ная с панелями Effects (Эффекты) и Info (Информация)) сохраня-
ет выполненные действия и позволяет отменить все или некоторые 
из них, если получившийся результат вам не нравится. В некотором 
смысле эта панель является визуальным представлением команды 
меню Undo (Отменить). При возврате в предыдущее состояние, все 
изменения, выполненные после выбранного момента, также отменя-
ются. Иначе говоря, нельзя выбрать для отмены только один ошибоч-
ный шаг, затерявшийся в середине списка.

Панель Audio Clip Mixer (Мик-
шер аудиоклипа)

Панель Effect Controls (Управление эффектами) Панель 
инстру-
ментов
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Настройка рабочего пространства

Помимо возможности настройки рабочих пространств, используемых по 
умолчанию (в зависимости от решаемых задач), вы  можете  настроить ме-
стоположение и размеры панелей так, чтобы создать рабочее простран-
ство, которое было бы максимально удобным для вас. Настроив рабочее 
пространство, вы можете сохранить его на жестком диске или даже соз-
дать несколько рабочих пространств для решения различных задач.

• При изменении размера одной панели  размеры других автоматически 
изменяются, чтобы заполнить освободившееся пространство в окне 
программы.

• Все  панели , сгруппированные в один фрейм, можно открыть при по-
мощи вкладок с их именами.

• Все панели допустимо сгруппировать в любом фрейме, а также пере-
таскивать панель из одного фрейма в другой.

• Можно отстыковать панель от фрейма, перетащив ее на свободное 
пространство и превратив в независимую.

В данном упражнении вы поэкспериментируете с перечисленными функ-
циями и сохраните пользовательское рабочее пространство.

1 Щелкните по панели монитора источника, после чего установите 
курсор поверх вертикального разделителя между панелями монито-
ра источника и программы. Затем, нажав и удерживая кнопку мыши, 
перетаскивайте курсор влево и вправо, изменяя размеры указанных 
фреймов. Вы можете сделать так, чтобы мониторы в вашем рабочем 
пространстве имели разные размеры.

• Примечание. 
При перемещении 
панели приложение 
Adobe Premiere Pro 
подсказывает, куда ее 
можно передвинуть. 
Если поместить панель 
в свободную область 
прямоугольной формы, 
то она сгруппируется 
с выбранным фреймом 
в качестве дополни-
тельной вкладки. Если 
же перетащить панель 
в область трапецие-
видной формы, то она 
будет размещена 
в виде отдельного 
фрейма. 
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2 Установите курсор поверх горизонтального разделителя между па-
нелью монитора источника и панелью монтажного стола. Нажмите 
и удерживайте кнопку мыши. Перетаскивайте разделитель вверх 
и вниз, чтобы изменить размеры этих фреймов.

3 Удерживая кнопку мыши на левом верхнем углу вкладки Effects 
(Эффекты) (слева от ее названия), перетащите ее в центр панели мо-
нитора источника, чтобы пристыковать панель Effects (Эффекты) 
к данному фрейму.

Возможная область размещения подсвечивается в центре панели

Если в один фрейм входят несколько панелей, на экране могут отобра-
жаться не все вкладки. В таком случае над ними появится ползунок. Что-
бы просмотреть все вкладки, нужно перетаскивать его влево и вправо. 
Можно  также отобразить нужную панель на экране, выбрав ее название 
в меню Window (Окно).

4 Щелкните по маркеру перетаскивания панели Effects (Эффекты) и, 
удерживая кнопку мыши, перетащите панель в позицию рядом с пра-
вым краем панели Project (Проект), чтобы поместить ее в отдельный 
фрейм.

Как показано на рисунке, выделенная область размещения имеет фор-
му трапеции, которая занимает правую часть панели Project  (Проект). 
Отпустите кнопку мыши, и ваше рабочее пространство будет выглядеть 
примерно так, как отображено на рисунке справа.

Вы также можете отстыковывать панели, превращая их в отдельно сто-
ящие.
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Отображаемая область размещения имеет трапецие-
видную форму

Вам может потребоваться изменить размеры панелей, 
чтобы увидеть желаемые элементы управления

5 Щелкните по маркеру перетаскивания панели монитора источника 
и, удерживая кнопку мыши и клавишу Ctrl (Windows) или Command 
(OS X) на клавиатуре, перетащите панель в сторону, чтобы отстыко-
вать ее от фрейма. В данном случае область размещения будет гораз-
до более заметной, указывая на то, что панель станет плавающей.
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6 Отпустите  кнопку мыши и клавишу, чтобы создать плавающую па-
нель монитора источника. Можно потянуть за углы панели, меняя ее 
размеры.

7 Приобретя  богатый опыт в области видеомонтажа, вы, возможно, 
захотите упростить себе работу, создав и сохранив удобное рабочее 
пространство. Для этого выберите команду меню Window ⇒ Work-
space ⇒ New Workspace (Окно ⇒ Рабочее пространство ⇒ Новое 
рабочее пространство). Введите название нового рабочего простран-
ства и затем нажмите кнопку OK.

8 Чтобы  вернуться к стандартному рабочему пространству, выберите 
команду меню Window ⇒ Workspace ⇒ Reset Current Workspace 
(Окно ⇒ Рабочее пространство ⇒ Сброс текущего рабочего про-
странства).

Изменение настроек программы

Чем дольше вы будете работать с программой Adobe Premiere Pro, тем 
чаще у вас будет возникать желание приспособить ее для ваших конкрет-
ных нужд. Существует несколько типов настроек, которые для удобства 
работы собраны в одном диалоговом окне. Подробно они будут рассма-
триваться по мере необходимости в уроках с соответствующими упражне-
ниями. Сейчас давайте познакомимся с одной из простейших на строек:

1 Выберите команду меню Edit ⇒ Preferences ⇒ Appearance (Прав-
ка ⇒ Настройки ⇒ Вид) (Windows) или Premiere Pro ⇒ Preferenc-
es ⇒ Appearance (Premiere Pro ⇒ Настройки ⇒ Вид) (OS X).

2 В открывшемся диалоговом окне перетащите ползунковый регуля-
тор в группе Brightness (Яркость) влево или вправо, чтобы устано-
вить подходящий уровень яркости интерфейса. Затем нажмите кноп-
ку OK, чтобы применить изменения, или по кнопке Cancel (Отмена), 
чтобы восстановить первоначальные настройки.

По умолчанию применяется яркость, которая придает пользовательскому интерфейсу 
нейтральный серый цвет, способствуя правильному восприятию монтажером цветов 
видеоизображения.

� Совет. Когда вы вы-
берете самую темную 
настройку , цвет текста 
интерфейса програм-
мы станет белым. 
Данная функция при-
спосабливает интер-
фейс программы для 
работы в затемненных 
помещениях.
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Перемещение, синхронизация и создание резервной копии 
пользовательских настроек

Пользовательские настройки содержат ряд важных параметров. Значе-
ния, используемые по умолчанию, подходят в большинстве случаев, но 
вы, познакомившись с процессом монтажа, возможно, захотите изменить 
некоторые из них.

Adobe Premiere Pro CC содержит новую функцию обмена пользователь-
скими настройками между различными компьютерами: при установке 
приложения вам необходимо ввести адрес электронной почты и пароль 
вашей учетной записи Adobe ID, чтобы подтвердить право использования 
программы. Впоследствии вы можете использовать те же регистрацион-
ные данные для хранения своих настроек на сервисе Creative Cloud, что 
позволит синхронизировать и обновлять их из любой копии программы 
Adobe Premiere Pro на всех ваших компьютерах.

Вы можете синхронизировать настройки на экране приветствия, на-
жав кнопку Sync Now (Синхронизировать сейчас) или осуществить 
синхронизацию из окна программы, выполнив команду меню Premiere 
Pro ⇒ Ваш Adobe ID ⇒ Sync Settings now (Premiere Pro ⇒ Ваш Adobe 
ID ⇒ Синхронизировать настройки сейчас) (Windows) или File ⇒ Ваш 
Adobe ID ⇒ Sync Settings now (Файл ⇒ Ваш Adobe ID ⇒ Синхронизи-
ровать настройки сейчас) (OS Х).

Меню Sync Settings (Синхронизация настроек) позволяет получить доступ к командам, 
связанным с сервисом Creative Cloud.

Новая функция синхронизации настроек между несколькими устрой-
ствами упрощает перенос ваших параметров с одного компьютера на 
другой.
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Контрольные вопросы

1 Почему программа Adobe Premiere Pro считается нелинейным редактором?

2 Опишите стандартный рабочий процесс видеомонтажа.

3 Для чего используется браузер материалов?

4 Можно ли сохранить пользовательское рабочее пространство?

5 Для чего используется монитор источника, а для чего — монитор программы?

6 Как открепить панель от окна программы и сделать ее плавающей?

Ответы

1 Приложение Adobe Premiere Pro позволяет помещать видео-, аудио- и графические 
материалы в любую позицию последовательности монтажного стола, менять порядок 
следования клипов внутри последовательности, добавлять монтажные переходы, при-
менять эффекты, а также выполнять любое количество других шагов по видеомонтажу 
в произвольном порядке.

2 Нужно отснять видеоматериал, перенести его на компьютер, создать последователь-
ность видео-, аудио- и/или графических файлов на монтажном столе, применить эф-
фекты и наложить монтажные переходы, добавить титры и графику, смикшировать 
звук и экспортировать готовый проект.

3 Браузер материалов позволяет просматривать и импортировать рабочий материал без 
необходимости открывать дополнительные приложения за пределами окна програм-
мы. Он чрезвычайно полезен при работе с видеоматериалами, представленными в виде 
файлов .

4 Да. Любое пользовательское рабочее пространство можно сохранить, выбрав команду 
меню Window ⇒ Workspace ⇒ New Workspace (Окно ⇒ Рабочее пространство ⇒ Но-
вое рабочее пространство).

5 Панели мониторов используются для просмотра последовательности и несмонтирован-
ных исходных клипов. При работе с обоими мониторами — источника и программы — 
можно просматривать и обрезать сырой отснятый материал на мониторе источника, 
а монитор программы использовать для ознакомления с готовой последовательностью 
по мере ее компоновки.

6 Перетащите панель при помощи мыши, удерживая нажатой клавишу Ctrl (Windows) 
или Command (OS X).
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Обзор урока

Здесь вы освоите:

• настройку нового проекта;

• выбор настроек просчета и воспроизведения видео;

• выбор настроек отображения видео и аудио;

• выбор настроек формата видеозахвата;

• создание рабочих дисков;

• использование предустановок последовательности;

• пользовательскую настройку последовательностей.

� Выполнение данного урока займет примерно 45 минут.

Перед тем как приступить к работе, вам необходимо создать новый проект 
и выбрать настройки для первой последовательности. Если вы не знакомы 
с видео- и аудиотехнологиями, то можете поразиться огромному количеству 
всех этих настроек. К счастью, приложение Adobe Premiere Pro CC максимально 
упрощает работу с настройками проекта. Кроме того, принципы обработки видео- 
и аудиоматериалов остаются одинаковыми, независимо от создаваемого вами 
продукта.

Нужно лишь определиться с тем, что вы хотите получить в итоге. Чтобы помочь 
вам в вопросах планирования и управления проектами, здесь представлено большое 
количество информации по различным форматам и видеотехнологиям. Возможно, 
вы захотите вернуться к этой главе позже, по мере приобретения опыта работы 
с приложением Adobe Premiere Pro.

На практике вы вряд ли станете часто менять настройки проекта, используемые по 
умолчанию, но будет полезно познакомиться со всеми доступными параметрами.
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В этом уроке вы научитесь создавать новые проекты и выбирать 
настройки последовательности, которые позволяют управлять 
воспроизведением клипов программой Adobe Premiere Pro.
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Начало работы

В файле проекта Adobe Premiere Pro хранятся ссылки на все видео- и зву-
ковые файлы (называемые клипами), которые используются в данном 
проекте. Этот файл также содержит по крайней мере одну последователь-
ность — ряд поочередно воспроизводимых клипов со специальными эф-
фектами, титрами и звуковым сопровождением, представляющую собой 
готовую работу. Вы будете выбирать, какие фрагменты клипов должны 
использоваться и в каком порядке воспроизводиться. Прелесть монтажа 
с применением программы Adobe Premiere Pro заключается в том, что 
при желании вы можете изменить в своем проекте практически все.

Запомните, что файлы проектов Adobe Premiere Pro имеют расширение 
.prproj.

Видео- и аудиоклипы в последовательности проигрываются по порядку, как в готовом 
видеофильме

Начать работу в приложении Adobe Premiere Pro несложно. Нужно соз-
дать новый проект, выбрать одну из предустановок последовательности 
и приступить непосредственно к монтажу.

Создавая новую последовательность с конкретными настройками и по-
мещая в нее различные клипы, важно понимать, каким образом настрой-
ки влияют на воспроизведение программой видео- и аудиоклипов. Если 
предустановки последовательности не полностью соответствуют желае-
мому результату, их можно изменить.

Вам необходимо знать, какие фор-
маты применяются в вашей видео-
камере для хранения видео и звука, 
поскольку выбор настроек последо-
вательности обычно основывается на 
параметрах исходных клипов. Чтобы 
вам было проще выбрать подходящие 
настройки, предустановки последова-
тельности программы Adobe Premiere 
Pro названы в соответствии с различ-
ными видеоформатами, поэтому, если 

• Примечание. 
Многие термины, ис-
пользуемые в прило-
жении Adobe Premiere 
Pro, включая термин 
клип (буквальный 
перевод с английско-
го, clip — «вырезка»), 
были заимствованы из 
области «традиционно-
го» монтажа фильмов, 
в процессе которого 
монтажеры отрезают 
фрагмент кинопленки 
ножницами и откла-
дывают его в сторону 
для последующего ис-
пользования в готовом 
фильме.

• Примечание. 
Предустановки хранят 
различные настройки 
параметров, позволяя 
вам сэкономить время. 
Вы можете использо-
вать одну из существу-
ющих предустановок 
последовательности 
или создать собствен-
ную для дальнейшего 
использования.
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вы знаете, какой из них применяется в вашей видеокамере, то без труда 
выберете правильные настройки.

В этом уроке вы узнаете, как создавать новые проекты и выбирать на-
стройки, которые определяют способ воспроизведения клипов програм-
мой Adobe Premiere Pro. Вы также познакомитесь с различными типами 
звуковых дорожек, файлами предварительного просмотра, и научитесь 
открывать проекты, созданные в программах Apple Final Cut Pro и Avid 
Media Composer.

Выбор настроек проекта

Давайте начнем работу с создания нового проекта.

1 Запустите приложение Adobe Premiere Pro. Появится экран привет-
ствия.

  Список Recent Projects (Недавние проекты) будет содержать имена 
проектов, с которыми вы недавно работали. Если до настоящего мо-
мента вы не запускали программу Adobe Premiere Pro, он будет пуст.

  На экране приветствия доступно несколько элементов управления:

• New Project (Новый проект). Открывает диалоговое окно New 
Project (Новый проект).
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• Open Project (Открыть проект). Позволяет найти существующий 
файл проекта и открыть его, чтобы продолжить работу над этим 
проектом .

• Resources (Ресурсы). Открывает онлайн-версию справки. Для 
доступа к ней необходимо иметь подключение к Интернету.

• Exit (Выход). Завершает выполнение программы Adobe Premiere 
Pro.

• Sync Now/Sync Settings Now (Синхронизировать/Настроить 
синхронизацию): позволяет синхронизировать ваши пользова-
тельские установки с сохраненными в облаке Creative Cloud.

• Use Settings from a Different Account (Использовать настройки 
другой учетной записи): позволяет выбрать учетную запись Ado-
be ID для синхронизации установок.

2 Выберите действие New Project (Новый проект), чтобы открыть од-
ноименное диалоговое окно.

Открывшееся диалоговое окно содержит две вкладки: General (Общие) 
и Scratch Disks (Рабочие диски). Все настройки, представленные в дан-
ном диалоговом окне, могут быть изменены позднее. В большинстве слу-

• Примечание. 
В пользовательском 
интерфейсе програм-
мы Adobe Premiere Pro 
широко используются 
вкладки. Это эффек-
тивный способ отобра-
жения дополнительных 
параметров в ограни-
ченном пространстве.
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чаев будет достаточно использовать текущие настройки. Давайте позна-
комимся с ними поближе.

Настройки просчета и воспроизведения видео

При творческом подходе к работе с видеоклипами в ваших последова-
тельностях вы, вероятнее всего, будете прибегать к использованию тех 
или иных визуальных эффектов. Некоторые специальные эффекты могут 
быть воспроизведены незамедлительно — эффект применяется к вашему 
исходному видео, и вы видите результат сразу после того, как нажмите 
кнопку Play (Воспроизведение). Такая ситуация называется воспроизве-
дением в режиме реального времени.

В большинстве случаев оно более предпочтительно, поскольку вы може-
те видеть результаты своего творчества сразу после внесения изменений. 
Многие специальные эффекты в программе Adobe Premiere Pro поддер-
живают возможность воспроизведения в режиме реального времени.

Однако если вы используете большое количество эффектов или если ис-
пользуемые эффекты не поддерживают возможность воспроизведения 
в режиме реального времени, компьютер может оказаться не в состоянии 
показывать результаты с полной частотой кадров. Иначе говоря, прило-
жение Adobe Premiere Pro попытается проиграть ваши видеоклипы, при-
менив к ним выбранные специальные эффекты, однако отображаться бу-
дут не все кадры. Такая ситуация называется выбрасыванием кадров.

В том случае, когда для воспроизведения вашего видео требуется допол-
нительная обработка, приложение Adobe Premiere Pro отображает цвет-
ные линии вдоль верхнего края панели монтажного стола.

Нет ничего страшного, если при воспроизведении вашей последователь-
ности часть кадров пропадает! На конечном результате это никак не ска-
жется. Когда вы завершите монтаж видеофильма и экспортируете гото-
вую последовательность (дополнительную информацию можно найти 
в главе 18), качество видео будет максимальным, со всеми кадрами. Тем 
не менее в процессе монтажа эта особенность может вызывать определен-
ные неудобства, особенно, если вы привыкли быть абсолютно уверены 
в результатах применения выбранных эффектов при просмотре последо-
вательности. В этой ситуации есть одно простое решение: просчет.
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Что такое просчет и воспроизведение 
в режиме реального времени?

Чтобы понять, что означает просчет, представьте художника, который во-
площает свой замысел на бумаге, тратя на это время. Допустим, у вас есть 
слишком затемненный фрагмент видео. Вы добавляете специальный эф-
фект, чтобы сделать его светлее, однако ваша система видеомонтажа не 
способна одновременно воспроизводить исходное видео и при этом де-
лать его светлее. В данной ситуации ей пришлось бы выполнить просчет — 
просчитать эффект. С этой целью создается новый видеофайл, который 
представляет собой копию вашего исходного видеофайла с примененным 
специальным эффектом, делающим фрагмент видео светлее.

Когда воспроизводится та часть вашей последовательности, для которой 
был просчитан эффект, система незаметно переключается на воспроизве-
дение нового видеофайла, созданного в результате просчета. Этот файл 
воспроизводится точно так же, как и любой другой. И хотя внешне выглядит 
так, будто на исходное видео наложили выбранный эффект, на самом деле 
происходит воспроизведение обычного видеоклипа.

По завершении воспроизведения части вашей последовательности с «ос-
вет ленным» клипом система незаметно возвращается к проигрыванию 
других исходных видеофайлов.

Основным недостатком просчета является то, что для этой операции требу-
ется дополнительное свободное место на жестком диске, и кроме того, она 
занимает некоторое время. Также это означает, что вы будете просматри-
вать новый видеофайл, созданный на основе исходного видеоматериала, 
в результате чего может произойти потеря качества. Преимущество про-
счета заключается в том, что вы можете быть уверены, что система вос-
произведет результаты применения выбранного эффекта в наилучшем ка-
честве с полной частотой кадров.

Воспроизведение в режиме реального времени происходит… мгновенно! 
При использовании эффекта, поддерживающего такую возможность, си-
стема воспроизводит оригинальный видеоклип вместе с наложенным эф-
фектом, не дожидаясь его просчета. Единственным недостатком подобного 
подхода является его прямая зависимость от аппаратных ресурсов вашей 
системы. В случае использования приложения Adobe Premiere Pro вы мо-
жете существенно повысить ее производительность за счет использования 
подходящей видеокарты (см. врезку «Движок Mercury Playback Engine» да-
лее). Однако далеко не все эффекты поддерживают возможность воспро-
изведения в режиме реального времени.

Когда вы выполняете просчет, приложение Adobe Premiere Pro создает 
новый видеофайл, который выглядит точно так же, как выбранная часть 
вашей последовательности, со всеми примененными специальными эф-
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фектами. Каждый раз, когда воспроизводится данный фрагмент, про-
грамма автоматически и незаметно переключается на новый видеофайл 
и проигрывает его вместо исходной последовательности, а затем возвра-
щается к воспроизведению следующих клипов.

Это означает, что Adobe Premiere Pro может воспроизводить результаты 
применения специальных эффектов в максимальном качестве с полной 
частотой кадров, и при этом компьютеру не придется делать ничего, кро-
ме воспроизведения обычного видеофайла.

На практике, чтобы просчитать последовательность, достаточно нажать 
одну клавишу на клавиатуре (клавишу Enter) или выбрать соответству-
ющую команду в меню.

Если параметр New Project Rendering (Рендеринг нового проекта) до-
ступен, это значит, что ваше аппаратное обеспечение удовлетворяет ми-
нимальным требованиям для аппаратного ускорения.

В раскрывающемся списке вы увидите два значения:

• Mercury Playback Engine GPU Acceleration (CUDA) (Mercury Play-
back Engine с аппаратным ускорением (CUDA)). Если выбрать это 
значение, программа Adobe Premiere Pro будет выполнять многие за-
дачи по воспроизведению клипов в последовательности при помощи 
видеокарты с аппаратным ускорением, предоставляя в ваше распоря-
жение огромное количество эффектов с возможностью воспроизве-
дения в режиме реального времени и простое воспроизведение дан-
ных в различных форматах.

• Mercury Playback Engine Software Only (Mercury Playback En-
gine с программной поддержкой). Этот вариант использует все до-
ступные вычислительные ресурсы компьютера и тоже обеспечи-
вает существенный выигрыш в производительности по сравнению 
с воспроизведением не в режиме реального времени. Если в нем не 
установлена специальная видеокарта, будет отображаться только 
данный вариант, а параметр Renderer (Метод просчета) окажется 
недоступен.

При наличии подходящей видеокарты вы можете добиться гораздо луч-
шей производительности, выбрав вариант с аппаратным ускорением. 
В этом режиме программа Adobe Premiere Pro перекладывает часть ра-
боты по воспроизведению видео и применению визуальных эффектов на 
видеокарту.

Выберите этот вариант, если он доступен в раскрывающемся списке.
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Движок Mercury Playback Engine

В программе Adobe Premiere Pro CS5 компания Adobe реализовала движок 
под названием Mercury, который существенно улучшает производитель-
ность при воспроизведении видео, как никогда раньше ускоряя и упрощая 
работу с различными видеоформатами, специальными эффектами и видео, 
содержащим несколько слоев (для эффектов типа «картинка-в-картинке»).

Движок Mercury Playback Engine получил ряд улучшений в версий CS5.5 
и CS6 и в очередной раз был доработан в версии CC. Он обладает следую-
щими тремя основными возможностями.

• Производительность при воспроизведении. Усовершенствован 
способ воспроизведения видеофайлов, особенно для некоторых фор-
матов видео, которые очень сложно проигрывать. Например, если вы 
производите съемку, используя DSLR-фотоаппараты, высока вероят-
ность, что для записи видео применяется кодек H.264, а файлы в этом 
формате очень сложны для воспроизведения. Улучшенная версия 
движка Mercury Playback Engine позволяет проигрывать эти файлы без 
каких-либо проблем.

• 64-разрядность и многопоточность. Программа Adobe Premiere Pro 
является 64-разрядным приложением — это означает, что она может 
использовать всю доступную оперативную память вашего компьютера. 
Данная возможность особенно полезна при работе с видео высоко-
го разрешения. Движок Mercury Playback Engine также поддерживает 
многопоточность, что позволяет ему использовать все ядра централь-
ного процессора. Чем более мощным будет ваш компьютер, тем более 
высокую производительность вы получите при работе с программой.

• Поддержка спецификации CUDA и технологии Open CL. Если в ва-
шем компьютере установлена подходящая видеокарта или вы ис-
пользуете ноутбук Apple MacBook Pro с подходящим аппаратным обе-
спечением, Adobe Premiere Pro может делегировать часть работы по 
воспроизведению видео видеокарте вместо того, чтобы полностью за-
гружать этой работой центральный процессор, замедляя выполнение 
других задач. В результате вы получаете лучшую производительность 
и быстроту реагирования пользовательского интерфейса при работе 
с последовательностями и множеством специальных эффектов, кото-
рые будут воспроизводиться в режиме реального времени.

Список поддерживаемых видеокарт доступен по адресу www.adobe.com/
ru/products/premiere/tech-specs.html.

Настройки формата отображения для видео/аудио

Две следующие рассматриваемые настройки позволяют указать способ 
измерения времени в программе Adobe Premiere Pro для ваших видео- 
и аудиоклипов.
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В большинстве случаев вы будете использовать значения, установленные 
по умолчанию: Timecode (Временной код) для видео- и Samples (Сэм-
плы) для аудиоклипов. 

Эти настройки не влияют на способ воспроизведения видео- и аудиокли-
пов программой Adobe Premiere Pro, а только определяют способ изме-
рения времени.

Параметр Display Format для видео

Для параметра Display Format (Фор-
мат отображения) в группе элементов 
управления Video (Видео) доступно 
четыре значения. Выбор правильного 
значения для каждого конкретного 
проекта в основном зависит от того, 
чем является ваш исходный матери-
ал — видео или фильмом.

Секунды и кадры

При съемке видео при помощи цифровой видеокамеры фактически проис-
ходит захват серии неподвижных изображений снимаемого события. Если 
каждую секунду захватывается достаточное количество изображений, при 
воспроизведении эта серия картинок будет выглядеть как обычный видео-
клип. Каждое изображение называется кадром, а величина, определяю-
щая количество кадров, захватываемых каждую секунду, обычно называ-
ется количеством кадров в секунду (fps, frames per second).

Величина fps зависит от формата, применяемого в вашей фото/видеока-
мере, и от ее настроек. Стандартными значениями являются 23,976, 24, 
25, 29,97, 50 или 59,94fps. Некоторые видеокамеры позволяют выбирать 
различные значения fps с различными размерами кадра.

Программа Adobe Premiere Pro позволяет воспроизводить видео со всеми 
общепринятыми частотами кадров.

Доступны следующие значения:

• Timecode (Временной код). Значение, установленное по умолчанию. 
Временной код — это универсальный стандарт для представления ча-
сов, минут, секунд и отдельных кадров для видеофайлов или видео, 
снятого на ленточный носитель. Такой же способ представления при-
меняется в видеокамерах, профессиональных видеомагнитофонах 
и системах нелинейного монтажа по всему миру.
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• Feet+Frames 16mm (Футы+кадры 16мм) или Feet+Frames 35mm 
(Футы+кадры 35мм). Если ваши исходные файлы были получены 
в результате захвата материала с кинопленки, и вы планируете под-
готовить указания для студии, непосредственно осуществляющей 
монтаж кинопленки для создания готового фильма, вам может пона-
добиться использовать этот стандартный метод измерения времени. 
В данном случае представляется не время, а количество футов от на-
чала пленки, и дополнительно указывается число кадров до послед-
него целого фута. Это похоже на систему измерения футы/дюймы, но 
в данном случае вместо дюймов используются кадры. Поскольку ка-
дры на кинопленках шириной 16 мм и 35 мм имеют различные разме-
ры (и, соответственно, в одном футе содержится различное количество 
кадров), для каждой из этих пленок созданы отдельные на стройки.

• Frames (Кадры). При выборе этого значения происходит последова-
тельная нумерация кадров в видео, начиная с нуля. Такая возмож-
ность иногда полезна при работе над анимационными проектами, 
и кроме того, информацию в таком виде любят получать студии, не-
посредственно осуществляющие монтаж кинопленки.

Для этого упражнения оставьте выбранным значение Timecode (Времен-
ной код) для параметра Display Format (Формат отображения) в группе 
элементов управления Video (Видео).

Параметр Display Format для аудио

При воспроизведении звуковых фай-
лов время может быть представлено 
в виде выборок или миллисекунд.

• Audio Samples (Аудиовыборки). 
При записи цифрового аудио осуществляется выборка звука, захва-
тываемого микрофоном тысячи раз в секунду. В большинстве про-
фессиональных видеокамер это происходит 48 000 раз в секунду. 
Если выбрано значение Audio Samples (Аудиовыборки), программа 
Adobe Premiere Pro будет отображать время в ваших последователь-
ностях в виде часов, минут, секунд и выборок. Количество выборок 
в секунду будет зависеть от настроек вашей последовательности.

• Milliseconds (Миллисекунды). Если выбрано это значение, програм-
ма станет отображать время в виде часов, минут, секунд и тысячных 
секунды.

По умолчанию Premiere Pro позволяет увеличивать масштаб отображе-
ния последовательностей для просмотра отдельных кадров. Однако вы 
можете легко переключаться на просмотр аудио в соответствии с вы-
бранным форматом отображения. Эта мощная возможность позволяет 
выполнять мельчайшие изменения в звуковых файлах.
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Для этого упражнения оставьте выбранным значение Audio Samples 
(Аудиовыборки) для параметра Display Format (Формат отображения) 
в группе элементов управления Audio (Аудио).

Настройки формата захвата

Параметр Capture Format (Формат захвата) указывает программе Adobe 
Premiere Pro, какой формат необходимо использовать для файлов, сохра-
няемых на жестком диске вашего компьютера в процессе захвата видео 
с видеоленты.

Захват в форматах DV и HDV

Без дополнительного аппаратного обеспечения сторонних производите-
лей, программа Adobe Premiere Pro позволяет осуществлять захват ви-
део с DV- и HDV-видеокамер посредством FireWire- подключения, при 
условии, что в компьютере присутствует поддержка этого интерфейса. 
Интерфейс FireWire также называется IEEE 1394 и i.Link,

Он предоставляет удобный способ 
взаимодействия с ленточными видео-
камерами, поскольку для передачи 
видео и звука, управления подклю-
ченным устройством (чтобы через 
компьютер вы могли удаленно начинать воспроизведение на вашей ви-
деокамере, осуществлять перемотку, приостанавливать воспроизведение 
и т. д.) и передачи временного кода используется всего один кабель

Аппаратное обеспечение сторонних производителей, 

применяемое для захвата

Не все видеокамеры имеют встроенную поддержку интерфейса FireWire, 
поэтому вам может потребоваться дополнительное аппаратное обеспечение 
сторонних производителей, чтобы подключить видеокамеру к компьютеру.

Если вы используете дополнительное аппаратное обеспечение, следуй-
те прилагаемым к нему инструкциям по установке. Вероятнее всего, вы 
установите поставляемое вместе с ним программное обеспечение, кото-
рое обнаружит, что на компьютере установлена программа Adobe Pre-
miere Pro, и автоматически добавит дополнительные значения в этот рас-
крывающийся список (и другие списки).

Для настройки новых проектов в программе Adobe Premiere Pro следуйте 
инструкциям, прилагаемым к установленному вами оборудованию.

Дополнительную информацию по аппаратному обеспечению, применяе-
мому для захвата видео, и форматам видео, поддерживаемым програм-

• Примечание. 
Благодаря подклю-
чаемому модулю Adobe 
Mercury Transmit — 
новая возможность, 
появившаяся в версии 
CS6, — движок Mer-
cury Playback Engine 
позволяет повысить 
производительность 
при просмотре видео-
материала, переноси-
мого на компьютер 
с использованием карт 
видеозахвата.
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мой Adobe Premiere Pro, можно найти по адресу www.adobe.com/ru/
products/premiere/extend.html.

Пока пропустите эту настройку, поскольку мы не будем захватывать ви-
део с ленточной видеокамеры в этом упражнении, к тому же данную на-
стройку можно изменить в любой момент времени.

Настройка рабочих дисков

Каждый раз, когда программа Adobe Premiere Pro осуществляет захват 
(запись) видеоматериала с ленточных носителей или просчитывает спе-
циальные эффекты, на жестком диске вашего компьютера создаются но-
вые видеофайлы.

Термин  рабочие диски используют  
для описания места хранения раз-
личных файлов, связанных с ви-
деомонтажом. Это могут быть как 
жесткие диски, как следует из на-
звания, так и любое другое место 
для хранения файлов. Рабочие ди-
ски можно создавать в одном и том же местоположении или в разных — 
все зависит от вашего оборудования и требований к рабочему процессу. 
При работе с файлами чрезвычайно больших размеров вы можете полу-
чить некоторый выигрыш в производительности, разместив все рабочие 
диски на разных жестких дисках вашего компьютера.

Как правило, для хранения файлов, связанных с видеомонтажом, приме-
няется два подхода.

• Проектно-ориентированный. Все файлы, связанные с конкретным 
проектом, хранятся в той же папке, что и файл проекта.

• Системно-ориентированный. Файлы, связанные с несколькими 
проектами, сохраняются в одном централизованном расположении, 
а файлы проектов хранятся в другом месте.

Хранение файлов проекта

В дополнение к выбору расположе-
ния для хранения новых мультиме-
дийных файлов программа Adobe 
Premiere Pro позволяет также ука-
зать место для размещения файлов автосохранения. Это резервные ко-
пии файлов вашего проекта, автоматически создаваемые во время рабо-
ты. Если вам необходимо вернуться к более ранней версии проекта, вы 
можете открыть одну из таких копий.
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Использование проектно-ориентированного подхода

По умолчанию программа Adobe Premiere Pro сохраняет все вновь созда-
ваемые файлы в той же папке, где хранится файл проекта (этому вариан-
ту соответствует значение Same as Project (Также как и проект)). Хране-
ние всех файлов, связанных с проектом, и самого файла проекта в одном 
местоположении упрощает поиск связанных файлов. В качестве допол-
нительной меры по организации файловой структуры проекта можно 
переместить все файлы, которые вы собираетесь импортировать в него, 
в ту же папку, где находится файл проекта, и уже после этого выполнить 
импорт файлов из нового местоположения. Однако по завершении рабо-
ты достаточно удалить всего одну папку, в которой хранится файл про-
екта, чтобы стереть все его содержимое.

Использование системно-ориентированного подхода

Некоторые монтажеры предпочитают хранить все файлы, используе-
мые в различных проектах, в одном местоположении. Другим нравится 
размещать папки с захваченным материалом и папки предварительного 
просмотра в местоположении, отличном от местоположения файла про-
екта. Данный подход распространен в ситуациях, когда над проектами 
работает несколько монтажеров, и у каждого на компьютере установлена 
система видеомонтажа, подключенная к общим дискам для хранения ин-
формации. Такой подход также применяется монтажерами, которые ис-
пользуют очень быстрый жесткий диск для хранения видеофайлов и ме-
нее быстрый диск для хранения всего остального.

Стандартная конфигурация дисков 
и сетевого хранилища

Хотя  все  файлы и содержатся на одном жестком диске, стандартная схе-
ма видеомонтажа предусматривает использование двух отдельных дис-
ков: первый — для операционной системы и различных программ; второй 
(обычно более быстрый диск) — для хранения файлов, связанных с видео-
монтажом, включая захваченные видеофайлы и звуковые файлы, файлы 
предварительного просмотра, неподвижные изображения и экспортируе-
мые материалы.

В некоторых системах хранения информации используются возможности 
локальных вычислительных сетей для предоставления совместного досту-
па к хранилищу данных из различных систем видеомонтажа. Если вы пла-
нируете работать в программе Adobe Premiere Pro именно с такой конфи-
гурацией, проконсультируйтесь с вашим системным администратором по 
поводу выполнения необходимых настроек.
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Для данного проекта мы рекомендуем использовать для всех ваших рабо-
чих дисков настройку, установленную по умолчанию: значение Same as 
Project (Также как и проект).

1 Щелкните по полю ввода Name: (Имя) и введите название для ваше-
го нового проекта — Lesson 02.

2 Нажмите кнопку Browse (Найти) и выберите желаемое местополо-
жение для хранения файла проекта на жестком диске вашего ком-
пьютера.

3 Если ваш проект сконфигурирован правильно, настройки параме-
тров на вкладках General (Общие) и Scratch Disks (Рабочие диски) 
в диалоговом окне New Project (Новый проект) должны выглядеть 
так, как показано на следующем рисунке. Если все они совпадают, на-
жмите кнопку OK, чтобы создать файл проекта.

Импорт проектов Final Cut Pro

Программа Adobe Premiere Pro CC позволяет импортировать и экспор-
тировать последовательности и связи с файлами цифровых материалов, 
используя XML-файлы программы Final Cut Pro 7. Эти файлы хранят 
информацию обо всех монтажных решениях в универсальном виде, по-
нятном как для программы Final Cut Pro, так и для Adobe Premiere Pro.

• Примечание. 
При выборе местопо-
ложения для файла 
проекта в раскрываю-
щемся списке можно 
выбрать одно из 
последних использо-
вавшихся.
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Благодаря этой возможности вы можете использовать для работы над 
проектом оба приложения.

Экспорт XML-файлов из программы Final Cut Pro

Для создания XML-файла необходимо открыть файл проекта Final Cut 
Pro в программе Final Cut Pro. В процессе импортирования XML-файла 
в программу Adobe Premiere Pro вам понадобятся файлы цифровых ма-
териалов, используемых в Final Cut Pro. Adobe Premiere Pro может рабо-
тать с теми же файлами, что и Final Cut Pro.

1 Откройте существующий проект в программе Final Cut Pro.

2 Чтобы экспортировать весь проект, не выбирайте в нем никакие элемен-
ты; чтобы экспортировать только определенные элементы, выберите их.

3 Выполните команду меню File ⇒ Export ⇒ XML (Файл ⇒ Экспор-
тировать ⇒ XML). В появившемся диалоговом окне вы увидите ин-
формацию о том, какое количество корзин, клипов и последователь-
ностей было выбрано для экспорта.

4 В раскрывающемся списке Format (Формат) выберите значение 
Apple XML Interchange Format, version 4 (Формат Apple XML In-
terchange, версия 4), чтобы обеспечить максимальную совместимость 
экспортируемых данных с программой Adobe Premiere Pro.

5 Сохраните XML-файл в удобном местоположении (например, в пап-
ке с вашим файлом проекта).

Лучшая практика по работе 
с цифровыми материалами

Если вы планируете работать с обеими программами — Final Cut Pro и Ado-
be Premiere Pro — имеет смысл использовать форматы данных, с которыми 
могут легко работать обе системы видеомонтажа. Adobe Premiere Pro под-
держивает широкий диапазон форматов цифровых материалов и позволя-
ет без проблем работать с файлами в формате ProRes, поддерживаемом 
программой Final Cut Pro.

По этой причине для импортирования цифровых материалов и захвата ви-
део с видеоленты лучше использовать программу Final Cut Pro. Если вы соз-
дадите свой проект в программе Final Cut Pro, используя файлы цифровых 
материалов в формате ProRes, то впоследствии сможете легко передавать 
информацию о проектах в программу Adobe Premiere Pro и обратно.

Дополнительную информацию по совместной работе над проектами в про-
грамме Final Cut Pro можно найти на странице www.adobe.com/ru/prod-
ucts/premiere/extend.html.
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Импорт XML-файлов программы Final Cut Pro

XML-файлы программы Final Cut Pro 7 импортируются в программу 
Adobe Premiere Pro точно так же, как файлы любого другого типа (до-
полнительная информация представлена в уроке 3. В процессе импорти-
рования XML-файла программа Adobe Premiere Pro поможет вам связать 
последовательность и информацию о клипах с исходными файлами циф-
ровых материалов, используемых в программе Final Cut Pro. Существует 
ограничение на количество информации, включаемой программой Final 
Cut Pro в XML-файл, поэтому специальные эффекты, доступные в ней 
(например, корректировка цвета), не будут работать в Adobe Premiere 
Pro. Обязательно опробуйте описанные возможности на тестовом про-
екте перед тем, как принять окончательное решение по использованию 
обеих программ в процессе видеомонтажа.

Импорт проектов Avid Media Composer

Программа Adobe Premiere Pro CC позволяет импортировать и экспор-
тировать последовательности и связи с файлами цифровых материалов, 
используя файлы в формате AAF, экспортированные из программы Avid 
Media Composer. 

AAF-файлы хранят информацию обо всех монтажных решениях в уни-
версальном виде, понятном как для Avid Media Composer, так и для Adobe 
Premiere Pro.

Благодаря этой возможности вы можете использовать для работы над 
проектом оба приложения.

Экспорт AAF-файлов из программы Avid Media Composer

Для создания AAF-файла необходимо открыть файл проекта Avid Media 
Composer в программе Avid Media Composer. В процессе импортирова-
ния AAF-файла в программу Adobe Premiere Pro вам понадобятся файлы 
цифровых материалов, используемых в Avid Media Composer. Приложе-
ние Adobe Premiere Pro может работать с теми же файлами, что и Avid 
Media Composer.

1 Откройте существующий проект в программе Avid Media Composer.

2 Выберите последовательность, которую хотите экспортировать.

3 Выберите команду меню File ⇒ Export (Файл ⇒ Экспортировать).

В нижней части стандартного диалогового окна Export (Экспорт) про-
граммы Avid находится раскрывающийся список предустановок. Кнопка 
Options (Параметры), расположенная рядом со списком, позволяет за-
дать собственные настройки экспорта — щелкните по ней.
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4 В появившемся диалоговом окне Export Settings (Настройки экс-
порта) выполните следующее:

• выберите в раскрывающемся списке Export as (Экспортировать 
как) выберите пункт AAF Edit Protocol (Протокол правки AAF);

• установите флажок Include All Video / Data Tracks in Sequence 
(Включить все видеодорожки / дорожки с данными в последова-
тельности);

• установите флажок Include All Audio Tracks in Sequence (Вклю-
чить все аудиодорожки в последовательности);

• в раскрывающемся списке Export Method (Метод экспорта) на 
вкладке Video / Data Details (Видео / Данные) выберите значе-
ние Link to (Don’t Export) Media (Связать с цифровым материа-
лом (Не экспортировать));

• в раскрывающемся списке Export Method (Метод экспорта) на 
вкладке Audio Details (Аудио) выберите значение Link to (Don’t 
Export) Media (Связать с цифровым материалом (Не экспорти-
ровать));

• на вкладке Audio Details (Аудио) установите флажок Include 
Rendered Audio Effects (Включить сгенерированные звуковые 
эффекты);

• (необязательно) установите флажок Use Marks (Использовать 
маркеры) — в этом случае будут экспортироваться данные, рас-
положенные между точками In/Out (Вход/Выход);

• (необязательно) установите флажок Use Enabled Tracks (Ис-
пользовать активные дорожки).

5 Сохраните AAF-файл в удобном местоположении.

Импорт AAF-файлов программы Avid Media Composer

AAF-файлы программы Avid Media Composer импортируются 
в приложениеAdobe Premiere Pro точно так же, как файлы любого друго-
го типа (дополнительная информация представлена в уроке 3). В процес-
се импортирования AAF-файла Adobe Premiere Pro поможет вам связать 
последовательность и информацию о клипах с исходными файлами циф-
ровых материалов, используемых в Avid Media Composer. Существует 
ограничение на количество информации, включаемой приложением Avid 
Media Composer в AAF-файл, поэтому специальные эффекты, доступные 
в этой программе (например, корректировка цвета), не будут работать 
в Adobe Premiere Pro. Обязательно опробуйте описанные возможности 
на тестовом проекте перед тем, как принять окончательное решение по 
использованию обеих программ в вашем процессе видеомонтажа.
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Рекомендации по работе 
с цифровыми материалами

Avid Media Composer использует совершенно другую систему управления 
файлами цифровых материалов, нежели Adobe Premiere Pro. Тем не менее 
начиная с версии 3.5 в программе Media Composer используется новая си-
стема под названием AMA, которая допускает создание связей с файлами, 
находящимися не под контролем собственной системы организации фай-
лов. Файлы цифровых материалов, импортированные в приложение Avid 
Media Composer с использованием системы AMA, лучше подходят для по-
вторного связывания, когда AAF-файл импортируется в Adobe Premiere Pro. 
Цифровыми материалами, хранящимися в AMA-папках программы Avid 
Media Composer, могут быть любые файлы, которые способно воспроизво-
дить приложение Apple QuickTime, включая файлы в форматах P2, XDCAM 
и даже RED. Для воспроизведения этих файлов в системе видеомонтажа на 
базе программы Adobe Premiere Pro необходимо установить соответствую-
щие кодеки.

Как правило, для достижения наилучших результатов рекомендуется ис-
пользовать систему AMA приложения Avid Media Composer для установ-
ления связи с исходными цифровыми материалами в форматах P2 или 
XDCAM .

Дополнительную информацию по совместной работе над проектами в Avid 
Media Composer можно найти на странице www.adobe.com/ru/products/
premiere/extend.html.

Настройки последовательности

Сразу после создания файла проекта вы увидите новое диалоговое окно, 
предлагающее выбрать набор установок для первой последовательности. 
Adobe Premiere Pro всегда предполагает, что в вашем проекте будет не 
меньше одной последовательности, поэтому она предлагает создать эту 
последовательность перед началом работы над проектом. Программа адап-
тирует видео- и аудиоклипы, которые вы размещаете в данной последова-
тельности, таким образом, чтобы они соответствовали настройкам этой 
последовательности. Каждая последовательность в вашем проекте может 
иметь различные настройки, и крайне желательно, чтобы выбранные на-
стройки максимально соответствовали исходным цифровым материалам. 
В этом случае система будет тратить меньше ресурсов для воспроизведе-
ния клипов, улучшится производительность при воспроизведении в ре-
жиме реального времени и будет достигнуто максимальное качество.
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Автоматическое создание последовательности, 

соответствующей формату ваших исходных материалов

Если вы не уверены в том, какие настройки последовательности устано-
вить, не переживайте. Программа Adobe Premiere Pro имеет специальную 
возможность для создания последовательности на базе исходных цифро-
вых материалов.

В нижней части панели Project (Проект) находится кнопка меню New 
Item (Новый элемент) ( ). Вы можете использовать его для создания 
новых элементов, включая последовательности и титры.

Чтобы автоматически создать последовательность, соответствующую 
формату ваших исходных цифровых материалов, перетащите любой 
клип из панели Project (Проект) на кнопку New Item (Новый элемент).

Программа создаст новую последовательность, имя которой совпадет 
с именем клипа, а размеры и частота кадров будут соответствовать раз-
мерам и частоте кадров клипа. Теперь вы можете приступать к видеомон-
тажу, будучи уверенными, что настройки вашей последовательности вы-
браны правильно.

Выбор подходящей предустановки

Если вы знаете, какие конкретно настройки вам нужны, Adobe Premiere 
Pro откроет вам доступ ко всем возможным настройкам фильма. Если вы 
не слишком уверены, можете выбрать из списка предустановок.

Нажмите кнопку New Item (Новый элемент), расположенную в нижней 
части панели Project (Проект), и выберите пункт Sequence (Последова-
тельность).

Диалоговое окно New Sequence (Новая последовательность) состоит 
из трех вкладок: Sequence Presets (Предустановки последовательно-
сти), Settings (Настройки) и Tracks (Дорожки). Мы начнем со зна-
комства с вкладкой Sequence Presets (Предустановки последователь-
ности).

Вкладка Sequence Presets (Предустановки последовательности) зна-
чительно упрощает процесс настройки новой последовательности. При 
выборе предустановки программа Adobe Premiere Pro устанавливает 
настройки для вашей последовательности, максимально соответству-
ющие формату вашего видео и аудио. Выбрав подходящую предуста-
новку, вы можете внести необходимые 
изменения в существующие настрой-
ки на вкладке Settings (Настройки).

� Совет. Если формат 
первого клипа, до-
бавляемого в по-
следовательность, не 
будет соответствовать 
настройкам ее воспро-
изведения, программа 
предложит изменить 
настройки последо-
вательности, чтобы 
они соответствовали 
формату добавляемого 
клипа.
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В программе Adobe Premiere Pro доступен широкий набор готовых пред-
установок для наиболее распространенных форматов видео и аудио. 
Предустановки сгруппированы по форматам, применяемым в видеока-
мерах (конкретные предустановки находятся внутри папки, название ко-
торой соответствует названию формата).

Чтобы увидеть предустановки, доступные в отдельно взятой группе, 
щелк ните по значку треугольника, расположенному рядом с названием 
группы. Различные предустановки в пределах одной группы соответству-
ют, как правило, частоте и размерам кадров. Давайте рассмотрим пример.

1 Щелкните по значку треугольника напротив названия группы AVCHD.

На экране появятся три вложенных папки, соответствующие различным 
размерам и методам развертки кадров. Не забывайте, что видеокамеры 
зачастую могут снимать видео с применением различных разновидно-
стей HD-формата, отличающихся размерами кадров, а также их частотой 
и методами записи. Видеоматериал для следующего упражнения записан 
с использованием формата AVCHD 720p с частотой кадров 25fps.

2 Щелкните по значку треугольника напротив подгруппы с названи-
ем 720p.

• Примечание. 
Текстовая  область Pre-
set Description (Описа-
ние предустановки) 
на вкладке Sequence 
Presets (Предустанов-
ки последовательно-
сти) обычно содержит 
описание типов видео-
камер, применяющих 
данный формат для 
сохранения видео.
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3 Выберите предустановку с именем AVCHD 
720p25, установки которой максимально соот-
ветствуют нашему исходному видеоматериалу, 
щелкнув по названию предустановки.

Если вы никогда раньше не занимались видеомон-
тажом, огромное количество доступных форматов 
может немного обескуражить. Adobe Premiere Pro 
позволяет работать с широким диапазоном видео- 
и аудиоформатов и с легкостью воспроизводит различные материалы.. Тем 
не менее, когда форматы видеоклипов не соответствуют настройкам после-
довательности, программа, проигрывая их, вынуждена адаптировать эти 
клипы, затрачивая дополнительные вычислительные ресурсы, что в свою 
очередь оказывает влияние на производительность системы при воспро-
изведении в режиме реального времени. Поэтому имеет смысл приложить 
немного усилий перед началом процесса монтажа, чтобы выбрать настрой-
ки последовательности, которые будут максимально соответствовать ис-
ходным цифровым материалам. Вы увидите, что все предустановки сгруп-
пированы по типам видеокамер, упрощая выбор подходящих настроек.

Выбор нужной предустановки всегда будет зависеть от следующих 
основополагающих факторов: количество кадров в секунду, разрешение 
(количество пикселов в изображении) и кодек. Когда вы решите экс-
портировать последовательность в файл, частота кадров, аудиоформат, 
разрешение и другие настройки готового файла будут соответствовать 
настройкам, указанным для последовательности.

При экспорте последовательности в файл вы можете выбрать любой 
желаемый формат (дополнительная информация по экспортированию 
представлена в уроке 18).

Используя стандартную предустановку последовательности, вы може-
те внести некоторые изменения в параметры для обеспечения макси-
мальной поддержки исходных мультимедийных материалов. Для этого 
сначала выберите наиболее подходящую предустановку из числа стан-
дартных, а затем внесите изменения на вкладке Settings (Настройки). 
Для сохранения новой предустановки нажмите кнопку Save Preset (Со-
хранить предустановку) в нижней части вкладки Settings (Настройки). 
В появившемся диалоговом окне Save Settings (Сохранение настроек) 
укажите имя вашей пользовательской предустановки проекта, при жела-
нии оставьте комментарии к ней, после чего нажмите кнопку OK. Создан-
ная предустановка появится в папке Custom (Пользовательские) списка 
Available Presets (Доступные предустановки).

Вы можете использовать кодек Apple ProRes для предварительного про-
смотра файлов. Для этого в раскрывающемся списке Editing Mode (Ре-
жим монтажа) выберите значение Custom (Пользовательский), затем — 
значение QuickTime в раскрывающемся списке Preview File Format 
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(Формат файла предварительного просмотра) и значение Apple ProRes 
в раскрывающемся списке Codec (Кодек).

Изменение параметров предустановки

Выбрав предустановку с настройками последовательности, которые 
максимально соответствуют исходным видеоматериалам, возможно, вы 
захотите изменить некоторые настройки, чтобы они удовлетворяли ин-
дивидуальным особенностям вашей последовательности. Для внесения 
изменений щелкните по вкладке Settings (Настройки) и выберите зна-
чения параметров, которые должны использоваться программой Adobe 
Premiere Pro для воспроизведения ваших видео- и звуковых файлов. Не 
забывайте, что программа Adobe Premiere Pro будет автоматически адап-
тировать исходный видеоматериал, добавляемый на монтажный стол, 
в соответствии с настройками последовательности, формируя в резуль-
тате видео со стандартной частотой и размером кадров, независимо от 
исходного формата материалов.
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Форматы и кодеки

Различные форматы видеофайлов, например Apple QuickTime, MXF и Micro-
soft AVI, представляют собой контейнеры, которые могут содержать боль-
шое количество информации, записанной с использованием разнообраз-
ных видео- и аудиокодеков. В данном случае файл называется оболочкой, 
а информация, записанная с использованием кодека, — сущностью.

Кодек (англ. codec, сокращение от compressor/decompressor — кодировщик/
декодировщик) представляет способ хранения видео- и аудиоинформации.

При экспортировании готовой последовательности в файл вы будете ука-
зывать не только тип файла, но и кодек.

Максимальная глубина цвета 
и максимальное качество просчета

Если установить флажок Maximum Bit Depth (Максимальная глубина цве-
та), Adobe Premiere Pro станет выполнять просчет специальных эффектов 
с максимально возможным качеством. Часто это означает, что для пред-
ставления цвета будут использоваться 32-разрядные числа с плавающей 
запятой, с помощью которых можно получить миллиарды цветовых комби-
наций. Данный параметр позволяет добиться максимально высокого каче-
ства эффектов, но для этого компьютеру потребуется выполнять дополни-
тельные трудоемкие вычисления, поэтому, устанавливая данный флажок, 
будьте готовы к снижению производительности при воспроизведении по-
следовательности в режиме реального времени.

Если установить флажок Maximum Render Quality (Максимальное качество 
просчета) или если в вашем компьютере установлен графический ускоритель, 
программа Adobe Premiere Pro будет использовать более сложный алгоритм 
для масштабирования изображений. Без установки этого параметра вы мо-
жете видеть артефакты или шум на картинке при уменьшении масштаба изо-
бражения. При отсутствии графического ускорителя в вашей системе уста-
новка данного параметра будет существенно влиять на производительность.

Оба флажка допустимо устанавливать и сбрасывать в любой момент времени, 
поэтому вы можете выполнять монтаж, не прибегая к их использованию, — до-
статочно установить данные параметры при экспортировании готовой после-
довательности. Но даже если оба параметра будут включены, Adobe Premiere 
Pro обеспечит хорошую производительность и при использовании эффектов, 
поддерживающих воспроизведение в режиме реального времени.

Обратите внимание, что при использовании предустановки значения 
некоторых параметров изменить невозможно. Это значит, что данные 
настройки оптимизированы для использования с тем типом цифровых 
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материалов, который был выбран на вкладке Sequence Presets (Пред-
установки последовательности). Чтобы иметь максимальную гибкость 
в настройке параметров, в раскрывающемся списке Editing Mode (Режим 
монтажа) выберите значение Custom (Пользовательский), и вы сможете 
изменять значения всех параметров, представленных на вкладке Settings 
(Настройки). Она позволяет выполнять индивидуальные настройки 
предустановок, но если ваше видео соответствует одному из доступных 
вариантов предустановок, то производить изменения значений параме-
тров на этой вкладке не нужно, что и рекомендуется по умолчанию.

О типах звуковых дорожек

Если в диалоговом окне New Sequence (Новая последовательность) 
перейти на вкладку Tracks (Дорожки), вы сможете выбрать настройки 
дорожек новой последовательности. Добавляя видео- или аудиоклип 
в последовательность, вы помещаете его на дорожку. Дорожки — это 
горизонтальные области в последовательности, которые «удерживают» 
клипы в определенной позиции во времени. Если у вас есть несколько 
видеодорожек, любой видеоклип, размещенный на верхней дорожке, бу-
дет отображаться поверх тех, что размещены ниже (если они накладыва-
ются друг на друга во времени). Таким образом, если на верхней видеодо-
рожке размещается текст или изображение, а на нижней — видеоклип, вы 
увидите на экране их наложение.

Содержимое всех аудиодорожек воспроизводится одновременно, благо-
даря чему вы можете легко выполнить наложение звука. Для этого до-

� Совет. Для данного 
проекта не изме-
няйте настройки по 
умолчанию, а просто 
взгляните на то, как 
предустановка помо-
гает сконфигурировать 
новую последователь-
ность. Ознакомьтесь 
с каждым параметром 
и его доступными зна-
чениями на вкладке 
Settings (Настройки), 
чтобы получить пред-
ставление обо всех 
настройках, используе-
мых для корректного 
конфигурирования 
последовательности 
для видеомонтажа.
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статочно разместить несколько звуковых клипов на разных дорожках 
и правильно задать их позиции. Дикторский текст, звуки, специальные 
эффекты и музыку можно разместить на отдельных аудиодорожках, что-
бы организовать и упростить работу с вашей последовательностью.

Программа Adobe Premiere Pro позволяет задать нужное количество ви-
део- и звуковых дорожек в создаваемой последовательности. Добавить 
и удалить их можно будет позднее, однако после создания последователь-
ности вы не сможете изменить значение параметра Master (Контрольный 
вывод) группы элементов управления Audio (Аудио).

Аудиодорожки могут быть одного из нескольких типов. Каждый тип ау-
диодорожки применяется для добавления звуковых файлов определен-
ного типа. Для каждого типа дорожки приложение Adobe Premiere Pro 
предоставляет соответствующие инструменты для работы со звуком.

При добавлении клипа в последовательность, содержащую как видео-, 
так и аудиодорожки, программа следит за тем, чтобы аудиоклипы по-
мещались на дорожки подходящего типа. Вы не сможете по ошибке по-
местить аудиоклип на неправильную дорожку; при отсутствии аудиодо-
рожки подходящего типа Adobe Premiere Pro автоматически создаст ее.

В следующих разделах мы проведем краткий обзор каждого типа (а под-
робно изучим работу с аудиоматериалом в уроке 11).

Аудиодорожки

Аудиодорожки — это горизонтальные области, в которых размещают-
ся аудиоклипы. В программе Adobe Premiere Pro доступны следующие 
типы аудиодорожек:

• Standard (Стандартная). На дорожках этого типа могут размещаться 
как монофонические, так и стереофонические аудиоклипы.

• 5.1. Дорожки данного типа могут использоваться только для разме-
щения клипов в формате 5.1 (объемный звук).

• Adaptive (Адаптивная). Этот тип дорожки появился в программе 
Adobe Premiere Pro версии CS6. Дорожки адаптивного типа могут со-
держать как монофонические аудиоклипы, так и стереофонические, 
и обеспечивают точный контроль за их выводом.

• Mono (Моно). Данный тип дорожки применяется для размещения 
только монофонических аудиоклипов.

Субмиксы

Субмиксы — это специальная возможность для работы со звуком в про-
грамме Adobe Premiere Pro. Вместо основной дорожки разрешается вы-
вести звук с отдельно взятой дорожки вашей последовательности в суб-

• Примечание. 
После создания по-
следовательности вы 
не сможете изменить 
значение параметра 
Master (Контрольный 
вывод) группы элемен-
тов управления Audio 
(Аудио). Этот параметр 
позволяет указать 
один из режимов 
звучания для вашей 
аудиодорожки в гото-
вой последовательно-
сти: моно, стерео, 5.1 
или многоканальное 
звучание. Для выпол-
нения уроков, пред-
ставленных в данном 
пособии, мы будем 
использовать значе-
ние Stereo (Стерео). 
Если вы новичок в об-
ласти видеомонтажа, 
то, вероятнее всего, 
будете использовать 
значение Stereo (Сте-
рео) в подавляющем 
большинстве ваших 
проектов. Остальные 
значения используются 
в процессах професси-
онального видеомон-
тажа, например для 
создания объемного 
звучания в художе-
ственных фильмах.
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микс и затем использовать его для применения специальных звуковых 
эффектов и изменения громкости звука. Для одной аудиодорожки поль-
зы от этой возможности не много, но в каждый субмикс можно выводить 
звук с любого желаемого количества аудиодорожек. Это означает, что 
в проекте можно создать, например, десять аудиодорожек, которые будут 
управляться одним субмиксом. Проще говоря, совершив меньше щелч-
ков мышью, вы сможете выполнять гораздо больше действий.

Существуют следующие типы субмиксов:

• Stereo Submix (Стереофонический субмикс). Для вывода звука со 
стереофонических дорожек.

• 5.1 Submix (Субмикс 5.1). Для вывода звука с дорожек формата 5.1.

• Adaptive Submix (Адаптивный субмикс). Для вывода звука с моно-
фонических и стереофонических дорожек.

• Mono Submix (Монофонический субмикс). Для вывода звука с моно-
фонических дорожек.

Для нашей первой последовательности мы будем использовать значения, 
установленные по умолчанию. Тем не менее найдите время, чтобы позна-
комиться со всеми доступными на вкладке Tracks (Дорожки) параметра-
ми и их значениями.

1 Присвойте последовательности имя First Sequence, введя этот текст 
в поле ввода Sequence Name (Имя последовательности).

2 Нажмите кнопку OK, чтобы создать последовательность.

3 Выберите команду меню File ⇒ Save (Файл ⇒ Сохранить). Поздрав-
ляем! Вы только что создали ваш первый проект и последователь-
ность в программе Adobe Premiere Pro.

Если вы еще не скопировали материалы и файлы проектов на жесткий 
диск вашего компьютера, пожалуйста, сделайте это сейчас, перед изуче-
нием урока 3 (дополнительную информацию можно найти во введении 
к данному пособию).
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Контрольные вопросы

1 Каково назначение вкладки Settings (Настройки) диалогового окна New Sequence 
(Новая последовательность)?

2 Как выбрать подходящую предустановку последовательности?

3 Что такое временной код?

4 Как создать пользовательскую предустановку последовательности?

5 Какие варианты захвата доступны в программе Adobe Premiere Pro без установки до-
полнительного аппаратного обеспечения?

Ответы

1 Вкладка Settings (Настройки) служит для настройки уже существующих предустано-
вок или для создания новых. При работе со стандартными материалами достаточно вы-
брать одну из доступных предустановок последовательности.

2 Как правило, лучше выбирать предустановки, которые будут максимально соответство-
вать исходным материалам. Программа Adobe Premiere Pro упрощает процесс выбора, 
группируя предустановки в соответствии с различными форматами, применяемыми 
в видеокамерах.

3 Временной код — это универсальная профессиональная система измерения времени 
в часах, минутах, секундах и кадрах. Количество кадров в секунду зависит от применяе-
мого формата записи видео.

4 Установив необходимые параметры для вашей пользовательской предустановки, на-
жмите кнопку Save Preset (Сохранить предустановку), укажите имя предустановки 
и ее описание, и нажмите кнопку OK.

5 Программа Adobe Premiere Pro позволяет записывать файлы в форматах DV и HDV, 
при наличии на компьютере шины FireWire. Если в вашем распоряжении есть дополни-
тельные варианты соединения посредством установленного аппаратного обеспечения, 
обратитесь к документации, прилагаемой к вашему аппаратному обеспечению, чтобы 
правильно настроить соединение.
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Обзор урока

Здесь вы научитесь:

• использовать браузер материалов для загрузки видеофайлов;

• применять команду Import (Импортировать) для загрузки файлов изображений;

• выбирать местоположение для хранения кэшируемых файлов;

• производить захват видеоматериал с ленточных носителей.

� Выполнение данного урока займет примерно 75 минут.
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Перед тем как приступить к монтажу видео, необходимо сначала 
импортировать исходный материал в проект. Поскольку программа 
Adobe Premiere Pro позволяет работать с различными типами исходных 
материалов, существует несколько методов их поиска и импортирования.
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Начало работы

В этом уроке вы познакомитесь с процессом импортирования цифровых 
материалов в программе Adobe Premiere Pro CC. Чаще всего вы будете 
использовать браузер материалов — удобный обозреватель, работающий 
со всеми типами мультимедийных файлов, которые вам когда-либо по-
требуется импортировать в программу Adobe Premiere Pro. Также мы 
рассмотрим особые случаи, например импортирование изображений 
и захват видеоматериала с ленточных носителей.

В этом уроке вы будете использовать файл проекта, созданный в уроке  2.

1 Продолжайте работу с файлом проекта из предыдущего урока или от-
кройте его с жесткого диска вашего компьютера.

2 Выберите команду меню File ⇒ Save As (Файл ⇒ Сохранить как).

3 Присвойте файлу имя Lesson 03.prproj.

4 Выберите желаемое местоположение на жестком диске и нажмите 
кнопку Save (Сохранить), чтобы сохранить проект.

Если вы не сохранили файл проекта из предыдущего урока, можете от-
крыть файл Lesson 03.prproj, находящийся в папке Lesson 03.

Импорт материалов

Импортируя элементы в проект программы Adobe Premiere Pro, вы созда-
ете связь между исходным материалом и его представлением, хранящем-
ся в проекте. Это означает, что фактически вы не изменяете первоначаль-
ные файлы, а просто работаете с ними с применением недеструктивного 
подхода. Например, если вы хотите использовать в последовательности 
лишь один фрагмент клипа, остальные его части по-прежнему останутся 
в вашем распоряжении.

Для импортирования материалов в программу Adobe Premiere Pro суще-
ствует два принципиальных подхода:

• Стандартное импортирование с использованием команды меню 
File ⇒ Import (Файл ⇒ Импортировать).

• Импортирование при помощи браузера материалов.

Давайте рассмотрим преимущества каждого из этих подходов.
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Когда применяется команда Import

В использовании команды Import (Импортировать) нет ничего сложного 
(и, возможно, вы уже встречали аналогичную команду в других приложе-
ниях). Чтобы импортировать файл, выберите команду меню File ⇒ Im-
port (Файл ⇒ Импортировать). Вы также можете использовать сочета-
ние клавиш Ctrl+I (Windows) или Command+I (OS X), чтобы открыть 
стандартное диалоговое окно Import (Импорт).

Данный подход лучше всего подходит для импорта автономных ресур-
сов, например изображений и звуковых файлов, особенно если вы точно 
знаете, где именно на диске они находятся и хотите быстро их открыть. 
Этот подход не идеален для импортирования файлов, создаваемых виде-
окамерами, поскольку последние зачастую используют сложную струк-
туру папок для раздельного хранения аудио- и видеофайлов. Для работы 
с данными, полученными с видеокамер, лучше применять браузер мате-
риалов.

Когда применяется браузер материалов

Браузер материалов — это удобный инструмент для просмотра ваших 
материалов и их последующего импортирования в программу Adobe Pre-
miere Pro. Он корректно отображает файлы в форматах, используемых 
современными цифровыми видеокамерами, и позволяет конвертировать 

� Совет. Вы можете 
открыть диалоговое 
окно Import (Импорт), 
дважды щелкнув по пу-
стой области на панели 
Project (Проект).
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сложные структуры папок в понятные значки и метаданные. Последние 
содержат важную информацию, включая длительность видео, дату и тип 
файла, и возможность их просматривать существенно упрощает процесс 
выбора нужного клипа из длинного списка файлов или сцен.

Импорт ресурсов из программы Adobe Prelude

Программа Adobe Prelude — это один из компонентов семейства продук-
тов Adobe Creative Cloud, который можно использовать для организации 
видеоматериалов. Она имеет простой и понятный интерфейс. Знакомство 
с функциональностью Adobe Prelude выходит за рамки данного пособия, 
однако в документации к программе вы найдете исчерпывающие инструк-
ции по ее использованию, а также описание лучших способов организации 
клипов. Основное назначение программы Adobe Prelude — предоставить 
режиссерам или их помощникам инструмент для быстрого захвата видео, 
внесения пометок и даже транскодирования материалов для «безленточ-
ных» рабочих процессов.

Если у вас есть готовый проект Adobe Prelude, описанная последователь-
ность действий поможет вам отправить необходимые материалы в про-
грамму Adobe Premiere Pro:

1 Запустите программу Adobe Prelude.

2 Откройте проект, материалы из которого вы желаете перенести в про-
грамму Adobe Premiere Pro.

3 Выберите команду меню File ⇒ Export Project (Файл ⇒ Экспортиро-
вать проект).
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4 Установите флажок Project (Проект) в открывшемся диалоговом окне.

5 В поле Name (Имя) укажите название проекта.

6 В раскрывающемся списке Type (Тип) выберите пункт Premiere Pro, что-
бы экспортировать проект в формате программы Adobe Premiere Pro.

7 Нажмите кнопку OK. Откроется новое диалоговое окно.

8 Выберите папку для сохранения проекта и нажмите кнопку Choose (Вы-
брать). Проект в формате программы Adobe Premiere Pro будет создан.

9 Переключитесь на окно программы Adobe Premiere Pro и убедитесь, что 
в программе открыт проект, в который будут перенесены материалы.

10 Выберите команду меню File ⇒ Import (Файл ⇒ Импортировать). Фай-
лы импортированного проекта должны появиться на панели Project 
(Проект).

Теперь вы можете завершить работу с программой Adobe Prelude и за-
крыть проект.

• Примечание. 
Вы также можете ис-
пользовать браузер 
материалов, чтобы вы-
брать файл проекта.
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По умолчанию браузер материалов находится в левом нижнем углу рабоче-
го пространства программы Adobe Premiere Pro (если вы используете рабо-
чее пространство Editing (Монтаж)). Данная панель пристыкована к тому 
же фрейму, что и панель Project (Проект). Чтобы быстро открыть браузер 
материалов, можно также нажать на клавиатуре сочетание клавиш Shift+8.

Браузер материалов легко разместить в любом месте экрана, перетащив 
панель при помощи мыши, или отстыковать ее от фрейма и превратить 
в плавающую, щелкнув по значку меню в углу браузера и выбрав коман-
ду Undock Panel (Отстыковать панель).

Вы увидите, что принципы работы с браузером материалов не сильно от-
личаются от принципов работы с файлами в вашей операционной систе-
ме. В левой части панели доступно дерево папок для навигации, с треу-
гольниками около имен папок для перемещения по файловой иерархии. 
Вы можете использовать клавиши ↑ и ↓ для выбора элементов в списке, 
а клавиши ← и → — для перемещения по папкам (например, для откры-
тия каталога с целью просмотра его содержимого).

К основным преимуществам использования браузера материалов можно 
отнести следующее:

• возможность отображения файлов только определенного типа, на-
пример, JPEG, Photoshop, XML, AAF и других;

• автоматическое распознавание формата записи видеокамеры — AVCHD, 
Canon XF, P2, RED, ARRIRAW, Sony HDV и XDCAM (EX и HD);

• просмотр и настройка отображения метаданных, связанных с ваши-
ми клипами;

• корректное отображение материала, представляющего собой ряд кли-
пов, сохраненных на нескольких картах памяти. Такая ситуация часто 
встречается в профессиональных видеокамерах, и в этом случае про-
грамма Adobe Premiere Pro импортирует все файлы в виде одного кли-
па, даже если для записи материала использовались две карты памяти.

Использование браузера материалов

Браузер материалов в Adobe Premiere Pro позволяет легко просматри-
вать файлы  на вашем компьютере. 

Данная панель может оставаться открытой все время и располагаться 
в любом удобном для вас месте, обеспечивая непосредственный доступ 
к файлам материалов на жестком диске вашего компьютера. 

Это быстрый, удобный и максимально оптимизированный инструмент 
для поиска и импортирования видеоматериала.

� Совет. Если вам 
нужны ресурсы из дру-
гого проекта програм-
мы Adobe Premiere Pro, 
вы можете импортиро-
вать его в ваш текущий 
проект. Для этого до-
статочно найти нужный 
проект с помощью 
браузера материалов 
и затем перетащить 
его в текущий.

• Примечание. 
В процессе выпол-
нения упражнений 
данного урока вы 
будете импортировать 
файлы с жесткого дис-
ка своего компьютера. 
Для этого вы должны 
скопировать на него 
все содержимое DVD-
диска, прилагаемого 
к этому изданию. До-
полнительную инфор-
мацию можно найти 
в начале книги.
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Безленточный рабочий процесс

Безленточный рабочий процесс (также известный как файл-
ориентированный рабочий процесс) включает в себя следующие простые 
этапы: импорт видео с безленточной видеокамеры, его монтаж и после-
дующий экспорт готового видео. Программа Adobe Premiere Pro CC мак-
симально упрощает этот процесс, поскольку, в отличие от многих других 
систем видеомонтажа, она не требует, чтобы перед монтажом материалы, 
записанные с использованием безленточных устройств, были перекон-
вертированы в другие форматы. Приложение может непосредственно ра-
ботать с такими форматами как P2, XDCAM, AVCHD и даже форматами 
цифровых зеркальных фотоаппаратов, снимающих видео, не прибегая 
к какой-либо дополнительной конвертации данных.

Для достижения наилучших результатов при работе с материалами, за-
писанными в формате вашей видеокамеры, следуйте следующим реко-
мендациям:

1 Создавайте новую папку для каждого проекта.

2 Копируйте материалы с видеокамеры на ваш жесткий диск, применя-
емый для монтажа (обязательно сохраняйте существующую струк-
туру папок). Переносите всю папку с данными непосредственно из 
корневой директории карты памяти. Вы также можете использовать 
специальное приложение для переноса данных, которое обычно по-
ставляется вместе с видеокамерой, предназначенное для эффектив-
ного перемещения видеоклипов. Визуально убедитесь в том, что все 
файлы были скопированы и что размеры папок на карте памяти и на 
жестком диске совпадают.

3 В названии папки с видеоматериалами должна присутствовать ин-
формация о съемке, включая номер карты памяти и дату съемки.

4 Создайте запасную копию содержимого карт памяти на втором жест-
ком диске.

5 В идеальном случае желательно создать долговременный архив, ис-
пользуя один из методов резервного копирования на Blu-ray-диски, 
LTO-стримеры, и т. д.

Поддерживаемые типы видеофайлов

Довольно  часто при работе над проектом приходится монтировать вместе 
видеоклипы разных форматов, снятые на разные камеры. Для приложе-
ния Adobe Premiere Pro это не является проблемой, поскольку вы можете 
монтировать клипы с различными размерами кадров на одном монтаж-
ном столе. Браузер материалов позволяет работать с файлами практиче-

• Примечание. 
Вероятно , вы за-
хотите воспользо-
ваться программой 
Adobe Prelude, чтобы 
организовать процесс 
копирования и импор-
та мультимедийных 
материалов с безлен-
точных носителей.
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ски любого формата. Но его отличи-
тельная особенность — встроенная 
поддержка безленточных форматов.

К основным безленточным форма-
там, поддерживаемым Adobe Pre-
miere Pro, относятся следующие 
форматы:

• Форматы любых цифровых 
зеркальных фотоаппаратов, ко-
торые записывают видео непо-
средственно в виде .mov- или 
.mp4-файлов с использованием 
кодека H.264;

• Panasonic P2 (DV, DVCPRO, 
DVCPRO 50, DVCPRO HD, 
AVC-Intra);

• RED ONE, RED EPIC и RED 
Mysterium X;

• ARRIRAW;

• XDCAM SD, XDCAM EX, XDCAM HD и HD422;

• Sony HDV (при записи материала на съемные безленточные носите-
ли информации);

• AVCHD;

• Canon XF;

• Apple ProRes;

• Avid DNxHD MXF.

Поиск ресурсов при помощи браузера материалов

Хорошая новость состоит в том, что структура браузера материалов очень 
проста. Во многом эта панель похожа на веб-браузер (у нее тоже есть 
кнопки «Вперед» и «Назад» для навигации по иерархии папок). Кроме 
того, по краям панели располагается ряд кнопок для быстрого и удобно-
го выполнения распространенных задач. С браузером материалов поиск 
файлов превращается в довольно простой процесс.

1 Продолжайте работу с файлом Lesson 03.prproj из предыдущего 
упражнения. Проект не должен содержать никаких импортирован-
ных ресурсов.

� Совет. Фильтруй-
те ресурсы, которые 
ищете, при помощи 
раскрывающегося 
списка Files of Type 
(Тип файлов) в верхней 
части браузера мате-
риалов.
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2 Давайте восстановим первоначальное состояние рабочего простран-
ства. Выберите команду меню Window ⇒ Workspace ⇒ Editing 
(Окно ⇒ Рабочее пространство ⇒ Монтаж). Затем — команду Win-
dow ⇒ Workspace ⇒ Reset Current Workspace (Окно ⇒ Рабочее 
пространство ⇒ Сброс текущего рабочего пространства) и в появив-
шемся диалоговом окне нажмите кнопку Yes (Да).

3 Откройте браузер материалов, щелкнув по соответствующей вклад-
ке (по умолчанию эта панель пристыкована к панели Project (Про-
ект)). Увеличьте размер окна панели, потянув его вправо за правый 
край.

4 Давайте упростим просмотр содержимого браузера материалов. Уста-
новите указатель мыши поверх панели; затем нажмите на клавиатуре 
клавишу `. Как правило, она располагается в левом верхнем углу кла-
виатуры.

Теперь браузер материалов занимает весь экран. Вы можете изменить 
ширину областей панели для комфортной работы.

5 На панели браузера материалов откройте папку Lessons/Assets/Video 
and Audio Files/Theft Unexpected XDCAM. Вы можете открывать пап-
ки, дважды щелкая по ним мышью.

• Примечание. 
Браузер материалов 
скрывает файлы, 
которые не являются 
цифровыми видео- или 
аудиоматериалами, 
упрощая поиск нужных 
ресурсов.
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6 Перетащите вправо ползунковый регулятор, расположенный в левом 
нижнем углу браузера материалов и отвечающий за изменение разме-
ров миниатюр клипов. Вы можете выбрать любой размер, с которым 
вам удобно работать.

7 Щелкните по клипу в корзине, чтобы выбрать его.

Теперь вы можете просмотреть клип, используя соответствующие соче-
тания клавиш.

8 Нажмите клавишу L, чтобы начать воспроизведение клипа.
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9 Нажмите клавишу K, чтобы остановить воспроизведение.

10 Для перемотки клипа вперед нажмите клавишу J.

11 Поэкспериментируйте с воспроизведением других клипов. Если к ва-
шему компьютеру подключены колонки или наушники, вы должны 
услышать аудиодорожку.

Вы также можете несколько раз нажать клавишу J или L, чтобы увеличить 
скорость воспроизведения для быстрого просмотра клипов. Используйте 
клавишу K или Пробел для временной остановки воспроизведения.

12 Давайте импортируем имеющиеся клипы в наш проект. Нажмите со-
четание клавиш Ctrl+A (Windows) или Command+A (OS X), чтобы 
выделить их все.

13 Щелкните правой кнопкой 
мыши по одному из выделен-
ных клипов и в появившемся 
контекстном меню выберите 
команду Import (Импорти-
ровать).

В качестве альтернативного ва-
рианта импортирования клипов 
можно сделать следующее: вы-
делив клипы и нажав и удерживая кнопку мыши на любом из них, пе-
ретащите курсор на вкладку панели Project (Проект). Когда на экране 
появится данная панель, переместите его вниз и отпустите кнопку мыши 
в пустой области панели Project (Проект).

14 Переключитесь обратно на панель Project (Проект).

Импорт изображений

Изображения стали неотъемлемой частью современных видеоклипов, вы-
полняя две основные функции: передача информации и добавление визу-
ального стиля в готовый продукт. К счастью, программа Adobe  Premiere  
Pro может импортировать практически любое изображение и тип графи-
ческого файла. Особенно полезна поддержка файлов, сохраненных в соб-
ственных форматах флагманских продуктов компании Adobe по работе 
с изображениями, — программах Adobe Photoshop и Adobe Illust rator.

Импорт однослойных файлов Adobe Photoshop

Любой человек, занимающийся печатными изображениями или вы-
полняющий ретуширование фотографий, вероятнее всего, использует 
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в своей работе программу Adobe Photoshop. Это — «рабочая лошадка» 
индустрии графического дизайна. Adobe Photoshop представляет собой 
чрезвычайно мощный и универсальный инструмент, без которого уже 
невозможно представить современный процесс видеопроизводства. Да-
вайте посмотрим, как правильно импортировать два файла, созданных 
в данном приложении.

Для начала давайте импортируем простое изображение в формате Adobe 
Photoshop:

1 Щелкните по панели Project (Проект), чтобы выбрать ее.

2 Выберите команду меню File ⇒ Import (Файл ⇒ Импортировать) 
или нажмите на клавиатуре сочетание клавиш Ctrl+I (Windows) или 
Command+I (OS X).

3 В появившемся диалоговом окне Import (Импорт) перейдите в папку 
Lessons/Lesson 03.

4 Выберите файл Theft_Unexpected.psd и нажмите кнопку Open (От-
крыть).

Изображение, представляющее собой простой логотип, будет импорти-
ровано в проект программы Adobe Premiere Pro.

Знакомство с функцией Dynamic Link

Один из способов работы с приложением Adobe Premiere Pro состоит в при-
менении набора дополнительных инструментов. Возможно, вы использу-
ете подписку Adobe Creative Cloud, включающую в себя ряд компонентов 
для выполнения задач, связанных с видеомонтажом. В программах пакета 
присутствуют дополнительные средства, которые позволяют оптимизиро-
вать процесс постпроизводства видео.

Возможность использовать инструментарий Dynamic Link присутствует 
в нескольких приложениях пакета, однако поведение программы зависит 
от используемой пары приложений. Основное назначение Dynamic Link — 
минимизировать время, затрачиваемое на просчет или экспорт файлов.

Мы будем знакомиться с возможностями программы Dynamic Link на про-
тяжении всей книги, однако сейчас самое время привести пример, который 
позволит вам понять, как приложения компании Adobe способны взаимо-
действовать между собой. Используя функцию Dynamic Link, вы можете им-
портировать композиции из Adobe After Effects в проект Adobe Premiere Pro. 
После добавления они будут выглядеть и вести себя так же, как любой другой 
клип в вашем проекте. Если внести изменения в такую композицию в при-
ложении Adobe After Effects, изменения автоматически отразятся в проекте 
приложения Adobe Premiere Pro. Экономия времени на подобных вещах ста-
нет заметна, когда вы начнете работать над собственными проектами.
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Импорт многослойных файлов Adobe Photoshop

Программа Adobe Photoshop также позволяет создавать изображения 
с использованием нескольких слоев. Они подобны дорожкам на монтаж-
ном столе и помогают отделять элементы друг от друга. Слои допускает-
ся импортировать в проект программы Adobe Premiere Pro для индиви-
дуальной работы с каждым из них или для создания анимации.

1 Дважды щелкните мышью на пустой области панели Project (Про-
ект), чтобы открыть диалоговое окно Import (Импорт).

2 Перейдите в папку Lessons/Lesson 03.

3 Выберите файл Theft_Unexpected_Layered.psd и нажмите кнопку 
Open (Открыть).

4 На экране появится диалоговое окно Import Layered File (Импорт 
многослойного файла), в котором можно указать один из четырех 
способов интерпретации многослойного файла.

• Merge All Layers (Объединить все слои). Объединяются все слои, 
и файл импортируется в программу Adobe Premiere Pro в виде 
однослойного клипа.

• Merged Layers (Объединенные слои). Объединяются только вы-
бранные слои, и файл импортируется в программу Adobe Premiere 
Pro в виде однослойного клипа.

• Individual Layers (Отдельные слои). Импортируются в корзину 
только выбранные слои, при этом каждый слой из исходного фай-
ла представляется отдельным клипом.

• Sequence (Последовательность). Импортируются только вы-
бранные слои, каждый из них представляется отдельным клипом. 
При этом программа создает новую последовательность (размер 
ее кадров соответствует характеристикам импортируемого до-
кумента), в которой каждый слой размещается на отдельной до-
рожке (порядок размещения на дорожках соответствует порядку 
размещения слоев в исходном файле).

  Если выбрать значение Sequence (Последовательность) или Individ-
ual Layers (Отдельные слои), в диалоговом окне Import Layered File 
(Импорт многослойного файла) станет доступным раскрывающийся 
список Footage Dimensions (Размеры исходного материала):

• Document Size (Размер документа). Для выбранного слоя будут 
использоваться размеры исходного документа Photoshop.

• Layer Size (Размер слоя). Размеры кадров в клипах приводятся 
в соответствие с размерами содержимого слоев в исходном файле 
Photoshop. Размеры слоев, содержимое которых заполняет холст 
не полностью, могут быть уменьшены для удаления прозрачных 
областей.
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5 Для этого упражнения выберите в раскрывающихся списках значе-
ния Sequence (Последовательность) и Document Size (Размер доку-
мента) соответственно. Нажмите кнопку OK.

6 Взглянув на содержимое панели Project (Проект), вы увидите новую 
корзину с именем Theft_Unexpected_Layered. Дважды щелкните по 
значку корзины, чтобы просмотреть ее содержимое.

7 Дважды щелкните по последовательности Theft_Unexpected_Lay-
ered, чтобы загрузить ее.

8 Изучите содержимое последовательности на монтажном столе. По-
пробуйте использовать переключатель видимости дорожки для со-
крытия и отображения содержимого каждой дорожки и знакомства 
с тем, как происходит изоляция слоев.
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Советы по работе с файлами, созданными в программе Adobe Photoshop

Ниже приведено несколько полезных советов по импорту изображений, созданных в Adobe Photoshop.

• Можно импортировать изображения с разрешением до 16 мегапикселов (4096×4096 пикселов). 
Помните, что при импортировании многослойного документа Photoshop в виде последователь-
ности ее разрешение будет соответствовать размерам исходного документа (в пикселах).

• Если вы не планируете панорамировать или масштабировать изображения  , попробуйте созда-
вать файлы с размерами кадров, по крайней мере, не меньше, чем разрешение проекта. В про-
тивном случае вам придется увеличивать изображения, что может ухудшить их резкость.

• Импорт слишком больших файлов занимает значительный объем памяти и может замедлить ра-
боту над проектом.

• Если же вы планируете панорамировать или масштабировать изображения, старайтесь создавать 
такие, чтобы масштабированная или панорамированная область имела размер кадров, равный 
размерам кадра проекта. Например, если вы работаете с форматом 1080p и хотите выполнить дву-
кратное масштабирование изображения, его размеры должны составлять 3840×2160 пик селов.

Импорт иллюстраций Adobe Illustrator

В состав семейства Creative Cloud входит еще один компонент для рабо-
ты с графикой — Adobe Illustrator. В отличие от программы Adobe Pho-
toshop, которая в основном предназначена для работы с изображениями, 
состоящими из пикселов (то есть растровыми), приложение Adobe Illus-
trator используется для работы с векторной графикой. Другими словами, 
эта программа, как правило, применяется для создания технических ил-
люстраций, контурных рисунков и сложных изображений, которые мо-
гут масштабироваться без каких либо ограничений.

Давайте импортируем векторное изображение.

1 Дважды щелкните мышью на пустой области панели Project (Про-
ект), чтобы открыть диалоговое окно Import (Импорт).

2 Перейдите в папку Lessons/Lesson 03.

3 Выберите файл Brightlove_film_logo.ai и нажмите кнопку Open (От-
крыть).

Этот тип файла называется Adobe Illustrator  Artwork (Иллюстрация про-
граммы Adobe Illustrator). Обработки подобных файлов в приложении 
Adobe Premiere Pro происходит следующим образом.

• Подобно файлу Photoshop CC, импортированному в предыдущем 
упражнении, файл Adobe Illustrator многослойный. Однако в данном 
случае программа не предоставляет возможность импортировать его 
в виде отдельных слоев — они автоматически сводятся (объединяют-
ся в один).

• Примечание. 
Если щелкнуть правой 
кнопкой мыши по 
файлу Lower_Third.
ai на панели Project 
(Проект), в появившем-
ся контекстном меню 
можно увидеть команду 
Edit Original  (Изме-
нить оригинал). Если 
у вас на компьютере 
установлено приложе-
ние Illustrator, выбор 
команды Edit Original 
(Изменить оригинал) 
откроет файл в этой 
программе, где его 
можно будет отредакти-
ровать. Поэтому, даже 
если слои данного фай-
ла были объединены 
в приложении Adobe 
Premiere Pro, вы всегда 
можете вернуться 
в программу Illustrator, 
изменить исходный 
многослойный файл, 
сохранить его, и произ-
веденные изменения 
сразу же отобразятся 
в приложении Adobe 
Premiere Pro.
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• Также используется процесс под названием растеризация , то есть 
преобразование векторной (на основе кривых) графики Illustrator 
в растровый (на основе пикселов) формат, используемый в приложе-
нии Adobe Premiere Pro. Данное преобразование происходит на этапе 
импорта, поэтому перед импортированием изображения Illustrator 
в Adobe Premiere Pro убедитесь, что его размеры соответствуют ва-
шим требованиям.

• Программа Adobe Premiere Pro автоматически сглаживает края изо-
бражения Illustrator.

• Программа Adobe Premiere Pro преобразует все пустые области в про-
зрачный альфа-канал, так что через них будут видны изображения 
клипов на дорожках, расположенных ниже.

Запись временной дорожки с закадровым голосом

Не исключено, что довольно часто вам придется работать над видеопроектами, содержащими дорож-
ку с закадровым голосом. И хотя для ее создания рано или поздно будут привлечены профессионалы 
(или, по крайней мере, запись будет производиться в менее шумной обстановке, нежели рабочее 
место в шумном офисе), вы можете самостоятельно записать временную дорожку непосредственно 
в программе Adobe Premiere Pro. Такая возможность окажется весьма кстати, если необходимо осу-
ществить монтаж видео с привязкой к чему-либо.

Для записи временной дорожки с закадровым голосом выполните следующие действия:

1 Если вы не используете встроенный микрофон, убедитесь, что внешний микрофон правильно 
подключен к звуковой карте вашего компьютера. При необходимости обратитесь к документа-
ции по компьютеру или звуковой карте.

2 Выберите команду меню Edit ⇒ Preferences ⇒ Audio Hardware (Правка ⇒ Настройки ⇒ Звуко-
вое устройство) в системе Windows или команду Premiere Pro ⇒ Preferences ⇒ Audio Hardware 
(Premiere Pro ⇒ Настройки ⇒ Звуковое устройство) в операционной системе OS X, чтобы пра-
вильно сконфигурировать микрофон для его дальнейшего использования в программе Adobe 
Premiere Pro. Выберите подходящее значение в раскрывающемся списке Default Device (Устрой-
ство по умолчанию), например System Default Input/Output (Устройство ввода/вывода по умол-
чанию) или Built-in Microphone/Built-in Output (Встроенный микрофон/Встроенное устройство 
вывода), и нажмите кнопку OK.
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3 Если к вашему компьютеру подключены динамики, выключите их, чтобы избежать появления об-
ратной связи или эхо.

4 Загрузите последовательность и выберите пустую дорожку на монтажном столе.

5 Выполните команду меню Window ⇒ Audio Track Mixer (Окно ⇒ Микшер аудиодорожек) (кото-
рый обычно объединен с панелью монитора источника).

6 На панели Audio Track Mixer (Микшер аудиодорожек) нажмите кнопку Enable Track For Record-
ing (Включить запись дорожки) с изображением буквы R в верхней части той аудиодорожки, на 
которую хотите записать звук.

7 Выберите канал для записи в раскрывающемся списке Track Input Channel (Канал для записи на 
дорожку).

8 Щелкните мышью по красной кнопке Record (Запись) в нижней части панели Audio Track Mixer 
(Микшер аудиодорожек), чтобы перейти в режим записи.

9 Нажмите кнопку Play (Воспроизведение) на панели Audio Track Mixer (Микшер аудиодорожек), 
чтобы начать запись.

10 Если индикаторы показывают слишком высокий или слишком низкий уровень записи звука, вы 
можете настроить его в процессе записи, переместив ползунок регулятора уровня записи для ис-
пользуемой дорожки вверх (чтобы увеличить) или вниз (чтобы уменьшить). Если в верхней части 
индикаторов уровня записи звука загораются красные прямоугольники, с большой долей вероят-
ности можно говорить об искажении звука. Вы можете использовать следующие рекомендации: 
для громкого звука уровень записи должен находиться на уровне 0 дБ, а для тихого звука — на 
уровне 18 дБ.
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11 Нажмите кнопку Stop (Стоп), чтобы остановить запись.

12 Найдите фрагмент записанного звука. Созданный клип должен появиться на выбранной дорожке 
на монтажном столе, а также на панели Project (Проект). Вы можете выбрать клип на панели 
Project (Проект), и затем переименовать его или удалить из проекта.

Кэширование мультимедийных материалов

При импортировании видео- и аудиоматериалов в определенных форма-
тах программе Adobe Premiere Pro может потребоваться обработать эти 
файлы и сохранить их в кэше. В частности, это касается форматов с высо-
кой степенью сжатия. Импортируемые звуковые файлы преобразуются 
в файлы с расширением .cfa. Большинство файлов в формате MPEG при 
импортировании индексируются, в результате чего образуются файлы 
с расширением .mpgindex. Узнать о том, что создается кэшируемая версия 
импортируемого файла, можно по индикатору хода выполнения процес-
са в правом нижнем углу экрана.

Преимуществом использования кэша для хранения цифровых материа-
лов является улучшенная производительность во время предваритель-
ного просмотра. Это достигается за счет меньшей загрузки централь-
ного процессора компьютера. Вы можете управлять настройками кэша 
для дополнительной оптимизации производительности вашей системы. 
Программы Adobe Media Encoder, Adobe After Effects, Adobe Premiere Pro 
и Adobe Audition используют одну общую базу данных кэша для хране-
ния цифровых материалов, поэтому каждое из этих приложений может 
работать с одним и тем же набором кэшированных версий файлов.
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Для настройки параметров кэша выберите команду меню Edit ⇒ Pref-
erences ⇒ Media (Правка ⇒ Настройки ⇒ Мультимедиа) (Windows) 
или Premiere Pro ⇒ Preferences ⇒ Media (Premiere Pro ⇒ Настрой-
ки ⇒ Мультимедиа) (OS X). Ниже перечислены наиболее часто исполь-
зуемые параметры.

• Чтобы переместить сам кэш или его базу данных для хранения цифро-
вых материалов на новый диск, нажмите кнопку Browse (Найти) в груп-
пе элементов управления Media Cache Files (Файлы кэша для хранения 
мультимедийных материалов) или Media Cache Database (База данных 
кэша для хранения мультимедийных материалов) соответственно, в по-
явившемся диалоговом окне выберите желаемое местоположение и на-
жмите кнопку OK. В большинстве случаев не следует переносить базу 
данных кэша в новое местоположение после начала работы над проек-
том. Тем не менее ее необходимо периодически очищать.

• Чтобы очистить кэш, нажмите кнопку Clean (Очистить). В результа-
те из кэша будут удалены все файлы. Эту операцию рекомендуется 
выполнять после завершения работы над проектом, когда файлы, ис-
пользовавшиеся для предварительного просмотра, уже не нужны.

• Установите флажок Save Media Cache files next to originals when 
possible (При возможности хранить файлы кэшированных версий 
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цифровых материалов вместе с оригиналами), чтобы файлы кэширо-
ванных версий цифровых материалов хранились на том же диске, что 
и оригиналы. Как правило, такой вариант предпочтительнее. Если вы 
хотите, чтобы все хранилось в одном централизованном местополо-
жении, не устанавливайте этот флажок.

Ленточные мультимедийные носители против 
безленточных

Несмотря на то, что цифровые носители стали наиболее распространен-
ной формой хранения отснятого материала, до сих пор существует масса 
камер, записывающих видео на ленточные носители. К счастью, последние 
по-прежнему остаются популярным источником материала и полностью 
поддерживаются приложением Adobe Premiere Pro.

Перед использованием отснятого видео в проекте необходимо осуществить 
его захват с ленточного носителя и сохранить на жестком диске компью-
тера. Приложение Adobe Premiere Pro использует для захвата видео такой 
цифровой интерфейс, как FireWire или SDI (Serial Digital Interface — После-
довательный интерфейс для поточной передачи цифрового сигнала), уста-
новленный на компьютере. Программа сохраняет захваченный видеомате-
риал на диск в виде файлов и импортирует их в проект в качестве клипов.

Adobe Premiere Pro предлагает ряд инструментов для автоматизации неко-
торых этапов процесса захвата видео. Существует три основных подхода.

• Можно выполнить захват всей видеозаписи в виде одного длинного 
клипа.

• Можно указать для каждого клипа точки входа и выхода для последую-
щего автоматического пакетного захвата.

• В приложении Adobe Premiere Pro можно использовать функцию опре-
деления сцены для автоматического создания отдельных клипов в за-
висимости от того, когда вы нажимали кнопку Pause/Record (Пауза/
Запись) на видеокамере.

По умолчанию программа позволяет работать с видеоматериалами в фор-
матах DV и HDV, если ваш компьютер оборудован интерфейсом FireWire. 
Если вы хотите захватывать видео в других профессиональных форматах, 
потребуется использовать дополнительное устройство захвата видео. По-
добные устройства поставляются в различных форм-факторах — это может 
быть как контроллер, подключаемый к материнской плате компьютера, 
так и внешнее устройство, подключаемое через интерфейс FireWire, USB 
3.0 и Thunderbolt. Программа Adobe Premiere Pro CC помогает унифициро-
вать поддержку дополнительного оборудования, позволяя использовать 
преимущества движка Mercury Engine Playback для предварительного про-
смотра эффектов и видео на профессиональном мониторе, подключенном 
к компьютеру. Подробный список поддерживаемого оборудования можно 
найти на странице www.adobe.com/ru/products/premiere/extend.html.
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Контрольные вопросы

1 При импорте видеоматериалов в форматах P2, XDCAM или AVCHD должно ли при-
ложение Adobe Premiere Pro выполнять их конвертацию?

2 В чем заключается преимущество использования браузера материалов перед командой 
File ⇒ Import (Файл ⇒ Импорт) при импортировании цифровых материалов, снятых 
на безленточную видеокамеру?

3 Какими четырьмя разными способами можно импортировать многослойный файл фор-
мата Adobe Photoshop?

4 Где могут располагаться файлы кэша мультимедийных материалов?

Ответы

1 Нет. Приложение Adobe Premiere Pro CC имеет встроенную поддержку форматов P2, 
XDCAM и AVCHD.

2 Браузер материалов понимает структуры папок, применяемые в форматах P2 и XDCAM , 
и отображает клипы в удобном для пользователя виде.

3 Вы можете выбрать Merge All Layers (Объединить все слои) для объединения всех сло-
ев в один или же выбрать слои для объединения, указав вариант Merged Layers (Объ-
единяемые слои). Если вы хотите импортировать определенные слои в виде отдельных 
изображений, выберите пункт Individual Layers (Отдельные слои). Или же укажите 
вариант Sequence (Последовательность), чтобы импортировать выбранные слои и соз-
дать новую последовательность.

4 Вы можете размещать файлы кэша мультимедийных материалов в любом месте на вы-
бор или хранить рядом с исходными файлами (по возможности).
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Обзор урока

Здесь вы научитесь:

• использовать панель Project (Проект);

• организовывать клипы при помощи корзин;

• добавлять метаданные в клипы;

• использовать основные элементы управления воспроизведением;

• изменять характеристики отснятого материала;

• вносить изменения в клипы;

� Выполнение данного урока займет примерно 50 минут.
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После того как видеоклипы и звуковые файлы импортированы 
в проект, у многих пользователей возникает естественное желание 
заняться просмотром исходных материалов и добавлением клипов 
в последовательность. Однако перед этим рекомендуется потратить немного 
времени на организацию имеющихся ресурсов. В дальнейшем это позволит 
вам сэкономить немало времени в процессе поиска необходимых материалов.



96 УРОК 4 Организация цифровых материалов

Начало работы

Когда проект содержит множество клипов, импортированных с носите-
лей различных типов, управление всеми этими ресурсами и поиск того 
самого «волшебного кадра» в нужный момент времени может оказаться 
весьма непростой задачей.

В данном уроке вы познакомитесь с тем, как можно организовать клипы 
при помощи панели Project (Проект), которая является ядром любого 
проекта. Вы будете создавать специальные папки, называемые корзина-
ми, для распределения клипов по категориям. Вы также узнаете, как до-
бавлять к клипам важные метаданные и метки.

Мы начнем урок со знакомства с панелью Project (Проект) и способами 
организации клипов.

Но перед тем, как приступить к работе, убедитесь, что вы используете 
стандартное рабочее пространство Editing (Монтаж).

1 Выберите команду меню Window ⇒ Workspace ⇒ Editing 
(Окно ⇒ Рабочее пространство ⇒ Монтаж).

2 Выберите команду меню Window ⇒ Workspace ⇒ Reset Current 
Workspace (Окно ⇒ Рабочее пространство ⇒ Сброс текущего рабо-
чего пространства).

3 В появившемся диалоговом окне Reset Workspace (Сброс рабочего 
пространства) нажмите кнопку Yes (Да).

В этом уроке вы будете использовать тот же файл проекта, что и в уроке  3.

4 Продолжите работу с файлом проекта из предыдущего урока или 
откройте его заново, отыскав на жестком диске. Если у вас нет фай-
ла проекта с предыдущего урока, вы можете открыть файл Lesson 
04.prproj из папки Lesson 04.

5 Выберите команду меню File ⇒ Save As (Файл ⇒ Сохранить как).

6 Присвойте файлу имя Lesson 04.prproj.

7 Выберите желаемое местоположение на жестком диске и нажмите 
кнопку Save (Сохранить), чтобы сохранить файл проекта.

Панель Project

Любые ресурсы, которые вы импортируете в проект программы Adobe 
Premiere Pro CC, отображаются на панели Project (Проект). Помимо 
предоставления прекрасных инструментов, предназначенных для поиска 
клипов и работы с их метаданными, панель Project (Проект) также по-
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зволяет создавать специальные папки, называемые корзинами, которые 
можно использовать для организации ваших ресурсов.

Независимо от способа импортирования клипов, все, что добавляется 
в последовательность, должно присутствовать на панели Project (Про-
ект). Если на панели Project (Проект) удалить клип, который уже ис-
пользуется в последовательности, данный клип будет автоматически 
удален из последовательности. Но не стоит переживать по этому поводу, 
поскольку программа Adobe Premiere Pro всегда предупредит вас о воз-
никновении подобной ситуации.

Фильтр по 
содержимому 

корзины

Последова-
тельность

Заголовки 
столбцов

Клип

Просмотр 
в виде 
списка

Просмотр 
в виде 

миниатюр

Управле-
ние мас-
штабом

Сорти-
ровка ми-

ниатюр

Кнопка 
поиска

Кнопка соз-
дания новой 
корзины

Панель Project (Проект) не только дает возможность хранить все ваши 
клипы, но и предоставляет инструменты для изменения характеристик 
цифровых материалов.

Все они имеют, например, определенную частоту и соотношение сторон 
кадров, и вы можете захотеть изменить эти характеристики для вопло-
щения ваших творческих идей. Так, чтобы создать эффект замедленного 
движения, для видео с частотой кадров 60fps можно установить частоту 
кадров, равную 30fps. Кроме того, в вашем распоряжении может оказать-
ся видеофайл, имеющий неправильное соотношение сторон кадров.

Чтобы определить детали воспроизведения цифровых материалов, 
программа Adobe Premiere Pro использует связанные с ними метадан-
ные. Если вы хотите изменить их, это можно сделать на панели Project 
(Проект ).
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Настройка панели Project

Вероятнее всего, вам захочется периодически изменять размеры панели 
Project (Проект). Для просмотра клипов вы будете попеременно исполь-
зовать представления в виде списка или в виде миниатюр, но в некото-
рых случаях проще увеличить размеры панели, чтобы отобразить больше 
данных, нежели прокручивать ее содержимое в поисках нужного клипа.

Стандартное рабочее пространство Editing (Монтаж) спроектировано 
таким образом, чтобы максимально упростить пользовательский интер-
фейс, позволив вам сконцентрироваться на творческом процессе, а не на 
многочисленных элементах управления. Скрытая часть панели Project 
(Проект), называемая областью предварительного просмотра, отобража-
ет дополнительную информацию о клипах.

Давайте поближе познакомимся с этой частью панели:

1 Нажмите кнопку меню панели Project (Проект).

2 В появившемся списке выберите пункт Preview Area (Область пред-
варительного просмотра).

Область предварительного просмотра отображает разнообразную полез-
ную информацию о клипе, выбранном на панели Project (Проект), вклю-
чая размеры кадров, соотношение их сторон и длительность клипа.

Если кнопка List View (Список) ( ), расположенная в левом нижнем 
углу панели Project (Проект), не нажата, щелкните по ней мышью. В этом 
представлении для каждого клипа на панели Project (Проект) отобража-
ется много дополнительной информации, но для ее просмотра придется 
прокручивать содержимое панели по горизонтали.

Когда вам понадобятся разнообразные сведения о клипах, вы можете ис-
пользовать область предварительного просмотра.

� Совет. Существу-
ет быстрый способ 
отстыковки панели 
Project (Проект) от 
фрейма и ее отобра-
жения в полный экран. 
Для этого достаточно 
нажать на клавиатуре 
клавишу `. Данную 
операцию можно 
проделывать с любой 
панелью в программе 
Adobe Premiere Pro.

• Примечание. 
Обязательно  выпол-
ните шаги, перечис-
ленные в разделе «На-
чало работы» в начале 
урока.
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Обложка 
клипа

Тип 
клипа

Имя 
клипа

Разре-
шение

Воспроизве-
дение/Стоп

Формат звукового 
сопровождения

Длительность 
и скорость кадров

3 Нажмите кнопку меню панели Project (Проект).

4 Выберите в появившемся меню пункт Preview Area (Область пред-
варительного просмотра), чтобы скрыть область предварительного 
просмотра.

Поиск ресурсов на панели Project

Работа с клипами отчасти похожа на работу с листами бумаги на вашем 
рабочем столе. Если у вас есть всего несколько клипов, в этом нет ничего 
сложного. Если вы работаете с одной или двумя сотнями клипов, потре-
буется системный подход!

Один из способов облегчить процесс видеомонтажа — это потратить не-
много времени в самом начале работы на организацию клипов. Если есть 
возможность присвоить им имена на этапе захвата или после импорта 
в проект, вы можете существенно упростить себе жизнь. Даже если вы не 
присвоили клипам уникальные имена на этапе захвата видеоматериала 
с кассеты, вы можете присвоить имя каждой группе клипов, а програм-
ма Adobe Premiere Pro автоматически добавит порядковые номера 01, 
02, 03 и т. д. к именам клипов (дополнительная информация доступна 
в уроке  3).

1 Щелкните по заголовку столбца Name (Имя) в верхней части панели 
Project (Проект). Если щелкнуть по заголовку столбца Name (Имя), 
элементы на панели Project (Проект) будут отсортированы по алфа-
виту (в прямом или обратном порядке).

2 Прокрутите содержимое панели Project (Проект) вправо, чтобы уви-
деть заголовок столбца Media Duration (Длительность цифрового ма-
териала). В этом столбце отображается длительность каждого клипа .

• Примечание. Когда вы прокручиваете содержимое панели Project (Проект) впра-
во, программа Adobe Premiere Pro отображает в левой части панели имена клипов, 
чтобы вы могли легко определить, к какому из них относится та или иная инфор мация.

� Совет. Для прокрут-
ки содержимого па-
нели Project (Проект) 
по вертикали можно 
использовать колесико 
мыши.
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3 Щелкните по заголовку столбца Media Duration (Длительность циф-
рового материала). Программа Adobe Premiere Pro отсортирует кли-
пы с учетом их длительности. Обратите внимание на направление 
стрелки рядом с заголовком столбца Media Duration (Длительность 
цифрового материала). Когда вы щелкаете по заголовку, направление 
стрелки меняется на противоположное, позволяя сортировать клипы 
в порядке возрастания или убывания их длительности.

 

Если вы ищете клипы с определенными характеристиками — например 
длительностью или размерами кадров — может оказаться полезным из-
менить порядок отображения столбцов на панели Project (Проект).

4 Нажав и удерживая кнопку мыши на заголовке столбца Media Du-
ration (Длительность цифрового материала), перетащите его влево, 
пока не увидите разделитель синего цвета между заголовками столб-
цов Label (Метка) и Name (Имя). Когда вы отпустите кнопку мыши, 
столбец Media Duration (Длительность цифрового материала) рас-
положится справа от столбца Name (Имя).

Разделитель синего цвета обозначает позицию, в которой будет размещен перетаскивае-
мый столбец

Фильтр по содержимому корзины

Приложение Adobe Premiere Pro имеет 
встроенные инструменты поиска, кото-
рые помогут вам находить нужные циф-
ровые материалы в проекте. Даже в том 
случае, если вы импортировали исходные 
клипы с безленточной видеокамеры и их имена, мягко говоря, не совсем 
описательны, вы можете выполнять поиск элементов по другим критери-
ям, например, по размерам кадров или по типам файлов.

В верхней части панели Project (Проект) находится поле ввода Filter Bin 
Content (Фильтр по содержимому корзины), в которое вы можете вво-
дить текст для фильтрации клипов. Это очень быстрый и простой способ 
найти клип, если вы помните его название. Клипы, названия которых не 
соответствуют введенному вами тексту, будут скрыты, а подходящие ото-
бразятся на панели Project (Проект), даже если они находятся внутри 
корзин.

1 Введите в поле ввода Filter Bin Content (Фильтр по содержимому 
корзины) буквы joh.

• Примечание. 
Чтобы увидеть стрелку 
рядом с названием 
заголовка, вам может 
потребоваться увели-
чить ширину столбца, 
перетащив одну из его 
границ.

• Примечание. 
При импорте файлов 
иллюстраций и фото-
графий, например 
в форматах Photoshop 
PSD, JPEG или Illustra-
tor AI, в качестве их 
длительности указыва-
ется значение, опреде-
ляемое параметром 
Still Image Default 
Duration (Стандартная 
длительность непод-
вижных изображений), 
доступным на вкладке 
General (Общие) диа-
логового окна Prefer-
ences (Настройки).
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Приложение Adobe Premiere Pro отобразит только те клипы, в названии 
которых встречается введенная комбинация букв, то есть «joh». Обрати-
те внимание, что над полем ввода отображается имя проекта вместе со 
строкой «(filtered)» (применен фильтр).

2 Щелкните по значку ×, расположенному справа от поля ввода Filter 
Bin Content (Фильтр по содержимому корзины), чтобы удалить при-
мененный фильтр.

3 Введите буквы psd в поле ввода Filter Bin Content (Фильтр по содер-
жимому корзины).

Приложение Adobe Premiere Pro отобразит только те клипы, в названиях 
которых присутствует комбинация букв «psd», независимо от того, в ка-
ких корзинах они размещаются. 

В данном случае будет отображен всего один клип, импортированный 
ранее. Использование поля ввода Filter Bin Content (Фильтр по содер-
жимому корзины) подобным образом позволяет находить файлы опреде-
ленного типа.

Слева от поля ввода Filter Bin Content 
(Фильтр по содержимому корзины) 
находится кнопка меню, которая по-
зволяет просмотреть список последних 
введенных строк вместе с информаци-
ей о количестве клипов, соответствую-
щих каждому критерию поиска.

Справа от поля ввода Filter Bin Content (Фильтр по содержимому кор-
зины) находится раскрывающийся список In (Искать в), позволяющий 
указать, на основании чего приложение Adobe Premiere Pro должно вы-
полнять поиск клипов: всех доступных метаданных; только метаданных, 
отображаемых в настоящий момент времени (дополнительную инфор-
мацию можно найти далее в разделе «Работа с корзинами»); или слов, 
получаемых из скриптов (дополнительную информацию можно найти 
далее в разделе «Организация цифровых материалов при помощи анали-
за содержимого»).

Как правило, менять в этом списке значение All (Везде) на другое со-
всем необязательно, поскольку данный вариант прекрасно подходит для 
фильтрации клипов при условии корректного ввода искомых фраз. Не 
забудьте щелкнуть по значку ×, расположенному справа от поля ввода 
Filter Bin Content (Фильтр по содержимому корзины), чтобы удалить 
примененный фильтр.

• Примечание. Папки, создаваемые на панели Project (Проект), называются 
корзинами. Этот термин был позаимствован из словаря монтажеров кинофильмов. 
Панель Project (Проект) сама по себе является корзиной, поскольку внутри ее вы 
можете хранить клипы. Она работает точно так же, как любая другая панель.
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Поиск

Программа Adobe Premiere Pro также предоставляет функцию поиска 
с расширенными возможностями. Чтобы познакомиться с ней, давайте 
импортируем несколько дополнительных клипов.

1 Используя любой из описанных в уроке 3 методов, импортируйте 
в проект следующие файлы:

• Seattle_Skyline.mov из папки Assets\Video and Audio Files\General 
Views.

• Under Basket.mov из папки Assets/Video and Audio Files/Basketball.

2 Нажмите кнопку Find (Поиск) ( ), расположенную в нижней части 
панели Project (Проект). На экране появится диалоговое окно Find 
(Поиск) с дополнительными параметрами для поиска ваших клипов.

Диалоговое окно Find (Поиск) приложения Adobe Premiere Pro позво-
ляет выполнять поиск одновременно по двум различным критериям. Вы 
можете указать, должны ли искомые клипы соответствовать обоим или 
же только одному из критериев. Например, можно сформировать любой 
из следующих поисковых запросов:

• Найти клип, в названии которого встречаются слова dog И boat.

• Найти клип, в названии которого встречается слово dog ИЛИ слово 
boat.

Для создания поисковых запросов доступно несколько параметров:

• Column (Столбец). В этом раскрывающемся списке перечислены все 
названия столбцов, доступных на панели Project (Проект). После 
щелчка по кнопке Find (Найти) программа Adobe Premiere Pro будет 
выполнять поиск заданного значения только в указанном столбце.

• Operator (Оператор). Предоставляет список стандартных поисковых 
операторов. Используйте этот параметр, чтобы указать, должно ли 
выбранное свойство клипа содержать (Contains), полностью соот-
ветствовать (Matches Exact), начинаться (Starts With) или заканчи-
ваться (Ends With) заданным значением.



ОФИЦИАЛЬНЫЙ УЧЕБНЫЙ КУРС ADOBE PREMIERE CC 103

• Match (Соответствие). Выберите значение All (Полностью), чтобы 
выполнить поиск клипа, который соответствует обоим критериям 
поиска. Значение Any (Любое) позволяет находить клипы, соответ-
ствующие только одному из указанных критериев.

• Case Sensitive (Учитывать регистр). Данный флажок позволяет ука-
зать приложению Adobe Premiere Pro, что при поиске должен учиты-
ваться регистр введенных вами символов.

• Find What (Искомое значение). В этом поле ввода можно указать ис-
комое значение. Диалоговое окно Find (Поиск) позволяет указать два 
таких значения (по одному для каждого критерия поиска).

Когда вы щелкнете по кнопке Find (Найти), программа Adobe Premiere 
Pro выделит подсветкой клип, который соответствует указанным запро-
сам. Если щелкнуть по кнопке Find (Найти) снова, программа Adobe 
Premiere Pro выделит подсветкой следующий найденный клип. Нажмите 
кнопку Done (Готово), чтобы закрыть диалоговое окно Find (Поиск).

Работа с корзинами

Корзины выглядят и ведут себя подобно папкам в операционной систе-
ме. Они позволяют обеспечить более организованное хранения клипов за 
счет разделения последних на различные группы.

Вы можете создавать одни корзины внутри 
других, создавая необходимую структу-
ру в соответствии с требованиями вашего 
проекта .

Тем не менее существует одно важное раз-
личие между корзинами и папками в опе-
рационной системе: корзины существуют 
только внутри файла проекта Adobe Pre-
miere Pro. Вы не увидите папки, соответ-
ствующие им, на жестком диске вашего 
компьютера.

Создание корзин

Давайте создадим корзину.

1 Нажмите кнопку New Bin (Новая корзина) ( ), расположенную 
в нижней части панели Project (Проект).

Приложение Adobe Premiere Pro создаст новую корзину и автоматически 
выделит ее имя, чтобы вы могли сразу же переименовать созданную кор-
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зину. Желательно, чтобы у вас вошло в привычку осмысленное именова-
ние корзин сразу после их создания.

2 У нас есть несколько фрагментов из фильма, поэтому давайте поме-
стим их в корзину. В качестве ее имени введите строку Theft Unex-
pected.

Создать корзину можно и через меню File (Файл).

3 Выберите команду меню File ⇒ New ⇒ Bin 
(Файл ⇒ Создать ⇒ Корзина).

4 Присвойте этой корзине имя PSD files.

Еще один способ создать корзину — щелкнуть 
правой кнопкой мыши по пустой области на па-
нели Project (Проект) и выбрать в появившем-
ся контекстном меню команду New Bin (Новая 
корзина).

5 Попробуйте выполнить это действие сейчас.

6 Присвойте новой корзине имя Illustrator 
files.

Один из самых быстрых и простых способов создать новую корзину для 
клипов, которые уже были импортированы в проект, — это перетащить 
их на кнопку New Bin (Новая корзина), расположенную в нижней части 
панели Project (Проект).

7 Перетащите клип Seattle_Skyline.mov на кнопку New Bin (Новая 
корзина).

8 Присвойте созданной корзине имя City Views.

9 Нажмите на клавиатуре сочетание клавиш Ctrl+/ (Windows) или 
Command+/ (OS X), чтобы создать новую корзину.

10 Присвойте корзине имя Sequences.

Если для отображения содержимого панели Project (Проект) использу-
ется представление List View (Список), для корзин применяется та же 
сортировка, что и для обычных клипов.

Управление содержимым корзин

Теперь, когда мы создали несколько корзин, давайте воспользуемся ими. 
По мере заполнения корзин клипами используйте значок в виде треу-
гольника, расположенный рядом с именем корзины, для сворачивания ее 

• Примечание. 
Когда панель Project 
(Проект) полностью 
заполнена клипами, 
найти пустую область 
может оказаться за-
труднительно. В этом 
случае попробуйте 
щелкнуть правой 
кнопкой мыши левее 
значков, но не выходя 
за пределы панели 
Project (Проект), или 
в верхней ее части (где 
находится поле ввода 
Filter Bin Content 
(Фильтр по содержимо-
му корзины)).

• Примечание. 
Если вы импортируете 
многослойный файл 
Adobe Photoshop 
и выбираете режим 
импорта слоев в виде 
последовательности, 
приложение Adobe 
Premiere Pro автома-
тически создаст новую 
корзину для слоев и их 
последовательности.
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содержимого и освобождения дополнительного пространства на панели 
Project (Проект).

1 Перетащите клип Brightlove_film_logo.ai в корзину Illustrator files.

2 Перетащите клип Theft_Unexpected.psd в корзину PSD files.

3 Перетащите корзину Theft_Unexpected_Layered (созданную авто-
матически при импортировании многослойного PSD-файла) в кор-
зину PSD files. Корзины, размещенные внутри других, функциони-
руют подобно вложенным папкам в операционной системе.

4 Перетащите клип Under Basket.mov в корзину City Views. Возмож-
но, вам потребуется изменить размеры панели Project (Проект) или 
переключиться в полноэкранный режим просмотра ее содержимого, 
чтобы увидеть одновременно и клип, и корзину.

5 Перетащите последовательность First Sequence 
в корзину Sequences.

6 Поместите все оставшиеся клипы в корзину 
Theft Unexpected.

В результате мы получили прекрасно организован-
ную панель Project (Проект), при этом клипы каж-
дого типа помещены в отдельные корзины.

Стоит отметить, что вы также можете копировать и вставлять клипы, соз-
давая их дополнительные копии, если того требует ваша организацион-
ная система. В вашем распоряжении есть документ Photoshop, который 
можно было бы поместить в корзину Theft_Unexpected. Давайте созда-
дим копию этого клипа.

7 Щелкните по значку треугольника рядом с именем корзины PSD 
files, чтобы отобразить ее содержимое.

8 Щелкните правой кнопкой мыши по клипу Theft_Unexpected.psd 
и в появившемся контекстном меню выберите команду Copy (Копи-
ровать).

9 Щелкните по значку треугольника рядом с именем корзины Theft 
Unexpected, чтобы отобразить ее содержимое.

10 Щелкните правой кнопкой мыши по корзине Theft Unexpected 
и в появившемся контекстном меню выберите команду Paste (Вста-
вить).

Приложение Adobe Premiere Pro поместит копию клипа в корзину Theft 
Unexpected.

• Примечание. 
Для выделения не-
скольких клипов на па-
нели Project (Проект) 
вы можете использо-
вать тот же прием, что 
и при работе с файла-
ми в вашей операцион-
ной системе — щелчок 
мышью при нажатой 
клавише Shift и Ctrl 
(Windows) или при 
нажатой клавише Com-
mand (OS X).

• Примечание. 
Создавая  копии кли-
пов, вы не создаете 
копии файлов, на кото-
рые эти клипы ссыла-
ются. Внутри проекта 
приложения Adobe 
Premiere Pro можно 
создать любое количе-
ство копий клипа. Все 
они будут ссылаться на 
один и тот же исходный 
файл.
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Определение местоположения файла

Если вы не уверены, в какой папке расположен файл на жестком диске 
вашего компьютера, щелкните правой кнопкой мыши по клипу на панели 
Project (Проект) и в появившемся контекстном меню выберите команду 
Reveal in Explorer (Открыть в Проводнике) (Windows) или Reveal in Finder 
(Открыть в Finder) (OS X).

Приложение Adobe Premiere Pro откроет папку на жестком диске, в которой 
хранится соответствующий файл, и выделит его. Эта функция может ока-
заться очень полезной, если вы работаете с файлами материалов, храня-
щимися на нескольких жестких дисках, или если вы переименовали клипы 
в проекте приложения Adobe Premiere Pro.

Управление представлением содержимого корзин

Несмотря на некоторое концептуальное различие между панелью Proj-
ect (Проект) и корзинами, они используют общие элементы управления 
представлением содержимого. Фактически, панель Project (Проект) 
можно считать корзиной.

Для отображения содержимого корзин используется два представления. 
Выбор того или иного осуществляется при помощи кнопок List View 
(Список) и Icon View (Миниатюры), расположенных в левом нижнем 
углу панели Project (Проект).

• List View (Список). Отображает клипы и корзины в виде списка вме-
сте с дополнительными метаданными. Вы можете прокручивать со-
держимое списка по горизонтали для просмотра метаданных, а также 
сортировать по ним объекты, щелкая мышью по заголовкам соответ-
ствующих столбцов.

• Icon View (Миниатюры). Отображает клипы и корзины в виде ми-
ниатюр (эскизов), которые можно перемещать и воспроизводить.

Для панели Project (Проект) также доступен элемент управления Zoom 
(Масштаб), позволяющий изменять размеры миниатюр клипов и корзин .

1 Дважды щелкните по корзине Theft Unexpected, чтобы открыть ее 
в отдельном окне.

2 Нажмите кнопку Icon View (Миниатюры) в окне корзины Theft Un-
expected, чтобы отобразить клипы в виде миниатюр.
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3 Переместите ползунковый регулятор Zoom (Масштаб). Приложение 
Adobe Premiere Pro позволяет отображать миниатюры очень боль-
ших размеров, чтобы упростить процесс поиска и выбора клипов.

Вы также можете применять различные виды сортировки к миниатюрам 
клипов в режиме Icon View (Миниатюры), нажав кнопку Sort Icons (Со-
ртировать миниатюры) ( ).

4 Переключитесь в режим представления List View (Список), нажав 
одноименную кнопку.

5 Переместите ползунковый регулятор Zoom (Масштаб). В режиме 
представления List View (Список) изменение масштаба отображе-
ния не имеет большого смысла, кроме случая, когда включена воз-
можность отображения миниатюр клипов в списке.

6 В меню панели Project (Проект) выберите пункт Thumbnails (Ми-
ниатюры).

Теперь приложение отображает миниатюры клипов как в режиме пред-
ставления List View (Список), так и в режиме представления Icon View 
(Миниатюры).

7 Переместите ползунковый регулятор Zoom (Масштаб).

Миниатюры клипов отображают первый кадр соответствующего мульти-
медийного файла. В некоторых случаях это не очень удобно. Взгляните 
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на клип HS Suit, например. Миниатюра отображает хлопушку, хотя по-
лезнее было бы видеть персонажа.

8 В меню панели Project (Проект) выберите пункт Preview Area (Об-
ласть предварительного просмотра).

9 Выделите клип HS Suit, чтобы отобразить информацию о нем в об-
ласти предварительного просмотра.

10 Элемент управления Thumbnail Viewer (Обозреватель миниатюр) 
в области предварительного просмотра позволяет воспроизводить 
клип, прокручивать кадры клипа путем перетаскивания ползунка 
и задавать обложку (миниатюру клипа). Используя ползунковый 
регулятор Thumbnail Viewer (Обозреватель миниатюр), прокрутите 
кадры клипа, чтобы найти кадр с персонажем.

11 Нажмите кнопку Poster Frame (Обложка) элемента управления 
Thumbnail Viewer (Обозреватель миниатюр).

Приложение Adobe Premiere Pro отобразит выбранный кадр в качестве 
миниатюры для данного клипа.

12 Используйте меню панели, чтобы отключить отображение миниатюр 
в режиме представления List View (Список) и скрыть область пред-
варительного просмотра.

Присваивание меток

Каждый элемент на панели Project (Проект) имеет цветовую метку. В ре-
жиме представления List View (Список) цветовые метки для каждого 
клипа отображаются в столбце Label (Метка). Когда вы добавляете кли-
пы в последовательность, для их отображения на монтажном столе ис-
пользуются цвета их меток.

Давайте изменим оттенок для титра, чтобы он соответствовал цвету дру-
гих клипов в данной корзине.

1 Щелкните правой кнопкой мыши по клипу Theft_Unexpected.psd 
и в появившемся контекстном меню выберите команду Label ⇒ Iris 
(Метка ⇒ Ирисовый).
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2 Убедитесь, что корзина Theft Unexpected активна, щелкнув по ней 
мышью.

3 Нажмите сочетание клавиш Ctrl+A (Windows) или Command+A 
(OS X), чтобы выделить все клипы в корзине.

Вы можете изменить цвет метки сразу нескольких клипов одновре-
менно.

4 Щелкните правой кнопкой мыши по любому клипу в этой корзине 
и в появившемся контекстном меню выберите команду Label ⇒ For-
est (Метка ⇒ Лесная зелень).

5 Верните цвет Iris (Ирис) для меток клипов корзины Theft Unex-
pected и измените цвет клипа Theft_Unexpected.psd на Lavender 
(Лаванда) (убедитесь, что изменились обе копии). Если эти клипы 
видны в обеих корзинах, вы увидите, как изменения вступят в силу.

Изменение доступных цветовых меток

В вашем распоряжении есть восемь цветов, которые могут быть присвое-
ны в качестве меток элементам вашего проекта. Также существует восемь 
типов элементов, которым могут быть присвоены цвета, а это значит, что 
в приложении отсутствуют резервные метки.

Если выбрать команду меню Edit ⇒ Preferences ⇒ Label Colors (Прав-
ка ⇒ Настройки ⇒ Цвета меток) в системе Windows или команду меню 
Premiere Pro ⇒ Preferences ⇒ Label Colors (Premiere Pro ⇒ Настрой-
ки ⇒ Цвета меток), вы увидите список цветов, напротив каждого из кото-
рых размещается образец цвета. Щелкнув по нему, вы можете изменить 
текущий цвет метки на любой другой.

Если в диалоговом окне Preferences (Настройки) выбрать раздел Label 
Defaults (Назначение меток по умолчанию), вы сможете изменить метки, 
используемые по умолчанию для каждого типа элементов в проекте.

• Примечание. 
Вы можете изменить 
цветовую метку одно-
временно для несколь-
ких клипов, пред-
варительно выделив 
их на панели Project 
(Проект).
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Переименование клипов

Поскольку клипы в вашем проекте существуют независимо от связанных 
с ними файлов мультимедийных материалов, вы можете переименовы-
вать элементы в приложении Adobe Premiere Pro, и при этом имена ис-
ходных файлов материалов на жестком диске будут оставаться неизмен-
ными. Именно поэтому переименование клипов не несет в себе никакой 
опасности!

1 Щелкните правой кнопкой мыши по каждому экземпляру клипа 
Theft_Unexpected.psd и выберите пункт меню Rename (Переимено-
вать).

2 Укажите для клипа новое имя TU Title BW.

3 Щелкните правой кнопкой мыши по только что переименованному 
клипу TU Title BW и в появившемся контекстном меню выберите 
команду Reveal in Explorer (Открыть в Проводнике) (Windows) или 
Reveal in Finder (Открыть в Finder) (OS X).

Обратите внимание, что имя исходного файла не изменилось. Важно чет-
ко понимать различие между файлами исходных материалов и клипами 
в проектах программы Adobe Premiere Pro, поскольку это во многом объ-
ясняет то, как работает данное приложение.

Настройка отображаемой информации в корзинах

По умолчанию приложение Adobe Premiere Pro отображает определен-
ные типы данных на панели Project (Проект). Вы можете легко добав-
лять или удалять столбцы с информацией. В зависимости от имеющихся 
клипов и типов метаданных, с которыми вы работаете, вы можете захо-
теть отобразить или скрыть столбцы с той или иной информацией.

1 Если корзина Theft Unexpected еще не открыта, откройте ее сейчас.

2 В меню панели выберите команду Metadata Display (Отображение 
метаданных).

• Примечание. 
При переименовании 
клипа в приложении 
Adobe Premiere Pro но-
вое имя клипа сохраня-
ется в файле проекта. 
В двух файлах проекта 
клип, ссылающийся на 
один и тот же исходный 
файл, может называть-
ся по-разному.


